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رشك     

الشجاعة والصبر والعزيمةأولا اشكر الرب الذي منحني    

واعبر عن تقديري العميق لها ودعمها  بالجامعة محمد خيضر بسكر ستااة  اما  اارر أستااة  اودو ان اشكر الأ

في ااجاز هذا العمل بشكل كبير ومهاراتها الاي لا تقدر بثمن والاي ستاهمت   

 كما اود ان اشكر جميع أعضاء لجنة الاحكيم الذين تفضلوا بقبو  الحكم على هذا العمل 

هذه المذكر  كل ما تعلماه خلا  مسيرتي الجامعية وشهاد  على امانان العميق لأستاتذتي الذين ستاهموا في تاناو  

 تدريسي 

 كما اشكر جميع أردقائي 

ان بن محمد الذي شجعني دائما على تحقيق ما ااا عليه الانكما اشكر رديقي ورفيقي ستفي  

ستمير على دعمهم الذي لا يقاس وتضحياتهم وأخيرا ااحني لما ادين لهم اكثر من غيرهم والدي واخي العزيز 
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Introduction générale 

Dans ce travail, nous étudierons théoriquement le système fer – carbone et plus 

précisément le domaine des mélanges ou se forme l’acier, vu l’importance industrielle et 

technologique de ces alliages et tandis que le diagramme de phases est le schéma topologique 

qui résume en une seule figure toutes les informations concernant les équilibre entre les 

différents phases en présence soit dans des conditions de concentration ou de température toutes 

ces argument justifie notre choix de faire cette étude. 

L'acier inoxydable est devenu incontournable dans de nombreux domaines (ménagers, 

construction, agro-alimentaire, médecine ... etc.). Les alliages fer- Carbone, c'est-à-dire les 

aciers et les fontes, jouent un rôle capital dans la technologie actuelle. Malgré l'apparition de 

nouveaux matériaux venant concurrencer les aciers. Le système fer- Carbone reste d'une grande 

importance pour le monde industrialisé. 

Le carbone est l’élément d’alliage le plus impressionnant dans les alliages de fer. Le 

diagramme de phase fer – carbone est considéré comme l'un des schémas fixes les plus 

importants en termes de Technologie et de base pour la conception des alliages d'acier, et ils 

représentent le plus important élément dans la détermination des zones thermiques. 

Ce travail réalisé dans le cadre de l’obtention d’un diplôme de Master en physique de la 

matière condensé sera subdivisé comme suit : 

Nous commençant par une introduction générale et puis un premier chapitre dans lequel 

nous allons présenter les diagrammes de phase unaire, binaire et ternaire. Dans le deuxième on 

traitera particulièrement le diagramme de phase fer – carbone. Le troisième chapitre, sera divisé 

en deux parties, la première est consacrée à la présentation du logiciel ImageJ qui sera 

pratiquement appliqué sur des échantillons virtuels dans la deuxième partie. Et on finira par une 

conclusion générale. 

 

 



 

 

 

 

 

 

 

 

 

Chapitre I : 

Les diagrammes de phases 

Concepts et définitions  
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I.1 Introduction  

Comprendre le comportement de mélange de métaux formant des alliages binaires ou 

ternaires, a toujours été un sujet d’intérêt majeur aux physiciens, aux chimistes et aux 

métallurgistes. 

Dans les domaines industriels ou technologiques les métaux sous leurs formes pures ne 

sont plus utilisés depuis des siècles La plupart des matériaux sont des mélanges d’atomes ou de 

molécules de nature différente appeler constituants. Si ces derniers sont solubles en toute 

proportion dans le matériau le mélange est dit homogène si non c’est à dire les constituants ne 

sont que partiellement miscibles le mélange est hétérogène, et le matériau contient alors 

plusieurs phases de composition et structure différentes. La combinaison de ces phases produit 

différentes microstructures qui influencent considérablement les propriétés et les 

caractéristiques techniques de ces matériaux. Les diagrammes de phases constituent la base 

pour analyser la formation des microstructures. Ils définissent d’une façon simple les états 

d’équilibre entre les phases [1]. 

I.2.Alliages  

La notion d’alliage était initialement réservée aux métaux. De maniéré classique, un 

alliage est un matériau à caractère métallique combinant un ou plusieurs métaux et 

éventuellement des éléments à caractère non métallique. Cette notion, qui est actuellement en 

pleine évolution, est progressivement étendue aux autres matériaux (céramiques, polymères), 

donc on peut définir un alliage comme une combinaison d’atomes, d’ions, ou de molécules pour 

former un matériau dont les propriétés différent de celles des constituants de base. Un alliage 

est généralement composé de plusieurs phases de taille microscopique ayant une composition 

et une structure différente qui contribuent de manière synergique aux propriétés du matériau 

[2]. 

I.2.1.Alliage homogène : 

Un alliage homogène peut être ordonné ou des atomes de différentes natures suivent une 

alternance stricte (Figure I.1.b) ou désordonné si les différents atomes occupent des places 

aléatoire dans ce qu’on appelle la matrice de base (Figure I.1.a) [3]. 

I.2.2.Alliage hétérogène  

Lorsque la teneur en élément d’alliage augmente, on peut avoir formation de deux 

phases : une phase contenant peu d’éléments d’alliage, et une phase à forte teneur en éléments 

d’alliage (Figure I.2) 

Les cristallites à forte teneur sont appelées « précipités ». Les précipités sont souvent 

des alliages ordonnés, que l’on appelle « intermétalliques » [3]. 
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Figure I.1 : alliage (a) désordonné, (b) ordonné [3]. 

 

 

Figure I.2 : Alliage hétérogène [3] 

I.2.3.Structures des alliages 

Dans le cristal d’un métal pur union quelconque est entouré par des voisins de même 

espèce Les forces de liaisons sont les même, car chaque ion possède le même nombre 

d’électrons libres (les valences sont égales). Par contre dans un cristal d’un alliage un, ion 

quelconque A est entouré par des voisins A ou B. Or les diamètres de A et B sont différents, le 

nombre d’électrons libres est différent aussi ainsi que les forces de liaison ne seront pas 

homogènes. 

Selon la différence relative du diamètre des ions et de leurs valences, on peut distinguer 

à première approximation  

 Solution solide (de substitution et d’insertion). 

 Combinaison chimique. 

 Mélange physique (mécanique) [4]. 

I.3.Une phase  

Toute zone de l’alliage possédant les mêmes propriétés physiques et chimiques et la 

mêmes composition séparée des autres parties par des interfaces, ces interfaces peuvent être 
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caractérisées par leur «énergie» spécifique inter faciale (Jm-²) qui joue un rôle important dans 

les transformations de phases et dans les mécanismes de rupture. [3] 

I.3.1.Les phases et leurs constituants :  

Chaque matériau est constitué d’un grand nombre d’atomes (~1023 par cm3) ou de 

molécules. Les éléments chimique dans le cas des métaux, les molécules dans le cas des 

polymères et les composés chimiques formant les céramiques, sont appelés constituants. 

Un alliage est donc, en général, composé de deux ou de plusieurs constituants et comporte 

une ou plusieurs phases. Une phase est une partie du système dans laquelle la composition 

(nature et concentration des constituants présents) et l’organisation atomique (structure 

cristalline on amorphe) sont fixées. Dans un système en équilibre. Chaque phase a une 

composition fixée qui est homogène sur tout le domaine d’existence. Dans les systèmes hors 

d’équilibre, très fréquemment rencontrés dans les matériaux, la composition peut varier en 

fonction du temps et de la localisation à l’intérieur du matériau considéré. Chaque phase est 

séparée des autres phases du système par une interface. Les phases amorphes et cristallines se 

distinguent par leurs arrangements atomiques différents. Dans la même optique, l’élément fer 

(Fe) peut exister à l’état de vapeur, liquide, de cristal cubique à faces centrées ou de cristal 

cubique centre, ce qui représente quatre phases différentes. A des pressions très élevées, comme 

celles existant à l’intérieur du globe terrestre, le fer forme également un cristal hexagonal [4]. 

I.3.2.Structure d’une phase  

Le critère d’analyse n’est pas suffisant pour s’assurer d’une phase dans un volume donné 

du matériau même très petit. Or une même phase ne peut posséder qu’une seule organisation 

structurale. On peut donc relier la notion de phase à celle de structure cristalline. La matière 

peut avoir une structure de type amorphe ou cristallisé. Donc on considérer comme un 

changement de phase tout passage amorphe → cristal ou tout changement de groupe de système 

cristalline [2]. 

I.3.3.Aspect densité ou masse volumique d’une phase 

A l’intérieur d’une même phase, on ne doit pas non plus observer une discontinuité de 

densité locale. Ce critère de densité pouvait être rattaché à la notion d’homogénéités de 

concentration locale si on utilisait comme paramétrer de mesure les concentrations volumiques 

à la phase des fractions molaires ou massiques. A l’intérieur d’une même phase la masse 

volumique ne doit subir aucune discontinuité [5]. 

I.3.4.Transformation de phase 

La transformation de phase est un changement des propriétés du système étudié 

provoquée par la variation d’un paramétrée extérieur particulier (température,…) ou par 
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l’application d’une contrainte. Cette transformation a lieu lorsque ces paramètres atteignent une 

valeur seuil. La présence ou non de la transformation de phases est gérée par les lois de la 

thermodynamique [3]. 

I.3.5.Transformation en phase solide 

Elle est soumis aux mêmes règles que la transformation du liquide en solide «la 

solidification» elle nécessite une surfusion pour former des germes stable, et la croissance de la 

phase est dépendante de la diffusion.  

La présence des surfaces internes et imperfection facilite beaucoup la germination, par 

contre la diffusion dans les corps solides est plus lente que dans les liquide mais elle a une 

grande importance [3]. 

I.4.Un diagramme de phase 

Le diagramme de phases, appelé aussi digramme d’équilibre, est une représentation 

géométrique de système matériel, généralement à deux ou trois dimension, qui résume en une 

simple figure un grand nombre de renseignements sur les conditions de température, de 

pression, de volume et de composition pour lesquelles les différentes phases d’un corps pur ou 

d’un mélange sont thermodynamiquement stables et en équilibre. 

Les diagrammes les plus simples concernent un corps pur ou les variables choisies pour 

faciliter leur étude sont la température et la pression ; les autres variables souvent utilisées sont 

l’enthalpie, l’entropie, le volume massique, ainsi que la concentration en masse ou en volume 

d’un des corps purs constituant un mélange. Lorsque le système étudié est un mélange de n 

corps purs, son état physique est défini par les (n-1) proportions indépendantes de ses 

composants, ainsi que par la température et la pression. Ainsi, un diagramme à deux variables 

ne peut donc être établi qu’en fixant (n -1) variable du système. C’est un diagramme à 

l’équilibre qui ne permet pas de décrire un système dans un état métastable comme par exemple, 

le cas de l’eau liquide à une température inférieure à 0 °C à la pression atmosphérique normale 

[5]. 

I.4.1.Diagramme système unaire 

Tout corps pur peut se présenter sous trois états (ou phases) différentes : solide, liquide 

ou gaz, selon la condition de température, de pression et de volume. Notre expérience la plus 

commune nous apprend que le domaine solide se situe à basse températures et sous fortes 

pressions, tandis que le domaine gazeux est caractérisé par de hautes températures et de faibles 

pressions. Nous savons que la région de l’état liquide est intermédiaire entre les deux 

précédentes [5]. 
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I.4.2. Allure générale des diagrammes de phases 

La mesure des couples de paramètres (Température -Pression), (Température-Volume) et 

(Pression-Volume) de coexistence de phase permet de tracer le diagramme des phases de tout 

corps pur. Ce dernier, a l’allure représentée par la (figure I.3). 

 

Figure I.3 : Diagramme de phases d’un corps pur en coordonnées (P, V, T).Projection des 

plans [6] 

I.5.Diagramme d’équilibres  

Les diagrammes (P,T) sont les plus couramment utilisés car les paramètres pression et 

température sont indépendants et intensifs. Bien que la pression et le volume soient 

thermodynamiquement conjugués, les diagrammes (P,V) ne sont pas fréquemment utilisés. 

I.5.1.Diagrammes (P, T) 

Le tracé des courbes d’équilibres (P, T) défini un diagramme d’équilibre, sur lequel on 

porte de part et d’autre de la courbe d’équilibre la nature de la phase stable dans ce diagramme 

il peut y avoir des intersections de courbes. Si une intersection est commune avec les équilibres : 

liquide-vapeur, liquide solide et solide vapeur, on parle de point triple. L’allure de l’ensemble 

des trois courbes associées aux trois états solide, liquide et vapeur figure sur le diagramme (P, 

T) de la (figure I.4).  

La ligne YC représente l’ensemble des conditions dans lesquelles on peut observer la 

coexistence d’un liquide et de sa vapeur, c’est le phénomène de liquéfaction et la transformation 

inverse est la vaporisation.  
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Figure I.4 : Représentation du système unaire en coordonnées (P, T) [6]. 

 

Le point critique noté C situé sur la courbe de vaporisation est le point d’arrêt de la 

coexistence liquide-vapeur c’est-à-dire qu’au-delà de ce point, on ne peut plus différencier les 

deux phases liquide et gaz. Il existe, alors, une seule phase appelée fluide. Donc, on peut passer 

de maniéré continue du gaz au liquide, car la différence entre liquide et gaz n’est pas qualitative, 

elle est uniquement quantitative car les phases liquide et gaz sont deux phases désordonnées 

qui ne se différent que par leur densité, ce qui explique que l’on puisse passer continument de 

l’une à l’autre [4].  

La branche YY’ sépare le liquide du solide. Il n’a pas de point critique sur cette branche 

qui décrit les conditions des transitions fusion-solidification. Ceci signifie que quelle que soit 

la pression, le passage du liquide au solide se fait toujours par une transition discontinue. Le 

solide où les atomes sont régulièrement disposés aux nœuds d’un réseau est toujours différent 

du liquide qui est une phase dense mais désordonnée.  

La branche OY décrit les conditions de coexistence du gaz et du solide. Le point Y 

s’appelle point triple où les trois (liquide, solide et gaz) sont en coexistence. Pour un corps pur 

donné, la pression et la température de ce point sont des constantes. Ces valeurs peuvent donc 

servir de points fixes pour une échelle de pression ou de température. Le diagramme (P, T) est 

souvent désigné sous le nom de diagramme de Clapeyron. 

I.6.Les Diagramme de phases binaire  

Le diagramme d’équilibre d’un système binaire est une représentation graphique des 

différents états sous les quels ce système existe à l’équilibre thermodynamique et c’est en 

fonction des variables d’état donc il répond à la question : la réaction chimique est-elle 

thermodynamiquement possible ? Autrement dit, pour un système binaire (constituer de deux 
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composants), un diagramme d’équilibre permet de représenter les domaines de stabilité des 

phases et les conditions d’équilibre entre plusieurs phases en fonction de la température de la 

composition. Une approche empirique permet de dire qu’un diagramme d’équilibre binaire est 

constitué de lignes appelées frontières qui isolent des surfaces appelées domaines. Un domaine 

peut être constitué d’une phase unique, de deux ou de trois phases au maximum [2]. 

La figure I.5 illustre le mode de représentation d’un diagramme de phase pour un système 

binaire, ou la température est porté sur l’axe des ordonnés et la composition sur l’axe des 

abscisses. 

 

Figure I.5 : Mode de représentation d’un diagramme de phases binaire [6] 

 

Ce type de représentation est employé pour les métaux, puisque les variations de pression 

sont très faibles au cours des changements de phases. Le tracé des diagrammes doit obéir à 

centaines règles topologiques imposées par la thermodynamique. Ces règles simples ont une 

forte importantes et permettent, en particulier, de dessiner correctement un diagramme à partir 

des points expérimentaux :  

1. Un diagramme biphasé (diphasé) est adjacent à deux domaines monophasés. 

2. deux domaines monophasés ou deux domaines diphasés peuvent pas être contigus, sauf si la 

ligne de séparation est horizontale (équilibre invariant entre trois phases) ou verticale (en fait 

une ligne double : le domaine de stabilité d’une phase peut être si étroit que le dessin confond 

ses deux limites de stabilité, cas des composés stœchiométriques. 

3. Les domaines monophasés et diphasés sont séparés par des lignes continues ou par des points 

singuliers. 
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4. Tangente en un point multiple (changement de pente des limites de phase à une température 

de transition des courbes doivent pénétrer les domaines diphasés) (Figure I.6). 

 

Figure I.6 : Disposition des courbes au palier d’invariance. [6] 

I.6.1.Aspect thermodynamique 

I.6.1.1.Variance (V)  

La variance d’un système est le nombre de variables indépendantes nécessaire et 

suffisant pour que la constitution chimique du composé soit définie. 

La variance est définie par la règle des phases(GIBBS) et elle ne peut jamais être négative [8] : 

 

 

C : Nombre de constituants indépendants dans le système. 

𝜑 : Nombre de phases distinctes les unes des autres et non miscibles l’une dans l’autre. 

2 : Signifie la variation simultanée des températures et de la pression.  

I.6.1.2.Systèmes binaires isomorphes  

 Cas est le plus simple des diagrammes de phases dont la solubilité solide mutuelle des 

deux Ce composants est complète (figure I.7). Exemple d’un système isomorphe : 

 Ni-Cu. La solubilité complète se produit parce que le Cu et Ni ont la même structure cristalline 

(CFC). Presque le même rayon, électronégativité et valence.  

 Ce diagramme est caractérisé par un (fuseau de solidification) délimité par deux courbes 

correspondant l’une au début de solidification (liquidus) et l’autre à la fin de solidification 

(solidus). Ces deux courbes aboutissent aux températures TA et TB qui correspondent aux 

températures de solidification (ou de fusion) des deux métaux purs. 

V=C + 2 –𝜑  
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Le fuseau compris entre le liquidus et le solidus correspond à la coexistence de deux phases 

constituées l’une par un liquide et l’autre par des cristaux formés par une solution solide de 

substitution de structure cristalline identique à celle des métaux A et B. 

 En fait, lorsque deux métaux cristallisent dans la même structure cristalline et ont des 

rayons métalliques voisins, ils donnent en général des alliages monophasés. Dans l’assemblage 

de l’un des métaux, tous les atomes peuvent être substitués par des atomes de l’autre métal sans 

changement de structure cristalline. Dans ce cas, les deux métaux sont totalement miscibles à 

l’état solide et froment une solution solide de substitution, quelle que soit la composition du 

mélange. [2]  

 Il est rare que deux métaux soient solubles en toute proportion à l’état solide car 

l’introduction d’un atome étranger dans le réseau d’un métal apporte des perturbations. La 

forme et la dimension du domaine biphasé par les propriétés thermodynamiques des 

constituants. La forme en fuseau indique, indépendamment de la courbure des liquidus et 

solidus, que les phases en équilibre sont proches de solutions idéales. En revanche, plus la forme 

est complexe, plus les solutions en équilibre s’éloignent de l’idéalité. [7] 

 

Figure I.7:.Diagramme à un seul fuseau [8]. 

Pour un mélange C : 

T=T1 : domaine monophasé : liquide  

T=T2 : Apparition des premiers germes cristallins dont la composition est donnée par l’abscisse 

du point correspondant à T2 sur le solidus (V = 2 +1 -2 = 1). 

V = C +1- 𝜑 = 3 – 𝜑 = 2  
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T=T3 : les pourcentages de la phase solide et ceux de la phase liquide peuvent être déterminés 

grâce à la réglé du bras de levier. 

A cette température, le matériau est partiellement solide et partiellement liquide. La 

composition du solide et celle du liquide pourront être retrouvées en traçant la ligne isotherme 

IS passant par m. 

T= T1 : fin de solidification ; il reste très peu de liquide dont la composition est donnée par 

l’abscisse du point correspondant à T4 sur le liquidus (V = 2 + 1- 2=1). 

T<T4 : Il n’existe plus qu’une seul phase. C’est une solution solide continue. [8] 

I.6.3.Systeme binaires eutectiques :  

Lorsque les deux constituants A et B n’ont pas la même structure cristalline et/ou que les 

rayons métalliques sont très différents, ils sont en général peu miscibles un exemple d’un tel 

système est représenté par la figure I.8.  

Aux extrémités de ce diagramme existent deux domaines limités en composition, la 

solution solide primaire qui présente la solubilité de B dans A (solution solide 𝛼) ayant la 

structure de A, et l’autre solution primaire qui présente la solubilité de A dans B (solution solide 

𝛽) ayant la structure de B. si l’on s’intéresse par exemple à un alliage de composition AXBX 

l’état  solide, à la température T0 il se présente sous la forme d’un seul phase forme par la 

solution solide 𝛼. Lorsque la température diminue pour atteindre la valeur T1, le maximum de 

solution du métal B dans A est franchi lors du passage par la température T𝛼 et l’alliage présente 

alors deux phases. L’une, majoritaire, est formée par la solution solide 𝛼 de composition définie 

par le point A0 et l’autre, riche en B, est formée par la solution solide 𝛽 et de composition 

définie par le point B0. Cette seconde phase précipite en général aux joints de grains de la 

solution solide 𝛼. Les points M et N correspondent aux extrémités d’un palier horizontal dit de 

transformation eutectique passant par le point d’eutexie E où se rejoignent les deux liquidus 

partant des points de fusion des métaux purs A et B. L’alliage de composition CE dénommé 

"eutectique"est caractérisé par une température de solidification constante comme les métaux 

purs, et présent une microstructure caractéristique constitué par des lamelles alternées des 

phases 𝛼 et 𝛽 de compositions respectives correspondant aux points M et N du palier eutectique. 

Cette constance du point de solidification est explicable par la règle des phases ou règle de la 

variance V qui, à pression atmosphérique constante, s’exprime par  

V=C+1-𝜑, ou C est le nombre constituants de l’alliage et 𝜑 le nombre de phases distinctes par 

leur état physique ou leur composition. Pour l’alliage CE à TE trois phases de composition CE 
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(liquide), CM et CN (solides) coexistent, la variance est donc nulle et le système n’ayant plus 

de degré de liberté la température est parfaitement déterminée. [2] 

 

Figure I.8 : Système binaire eutectique [8]. 

C = C1  

 Début de solidification à T1 

 Fin de solidification à T2 

 Etude similaire ai diagramme à un seul fuseau. 

C = C2   

 Début de solidification à T3  

 Fin de solidification à T4  

 Entre T3 et T4 : Réglé du Bras de levier pour déterminer les pourcentages de la phase 

solide S et de la phase liquide L, %A et %B. 

 à T = T5 : Limite de solubilité de A dans le réseau de B. 

 à T < T5 : Réglé du Bras de levier pour %𝛼 et %𝛽 (condensation des solides) 

C = C3  

 à T6 Début de solidification. 

 à T = TE : Fin de solidification. 

Coexistence des 3phases 𝛼, 𝛽 et L ⟶ V = 0, et palier sur l’ATS correspondant  

 à T < TE : Réglé du Bras de Levier pour %𝛼 et %𝛽 

C = CE  
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 T > TE : Phase liquide, 

 T = TE : 3Phases → V=0 

 T < TE : Réglé du Bras de Levier pour %𝛼 𝑒𝑡 % 𝛽. [8] 

I.6.4.Systeme binaires péritectique  

 Dans ce cas, la température de fusion de l’eutectique vient s’insérer entre la température 

de fusion des deux composés A et B purs (figure I.9) : le système est appelé péritectique. 

 Dans certains alliages la solidification s’effectuant par une transformation invariante 

entre trois phases comme dans le cas de la transformation eutectique peut conduire à une 

microstructure de l’alliage solidifié complétement différente. Cette transformation, dite 

péritectique, peut se définir par : 

𝑠𝑜𝑙𝑖𝑑𝑒 𝛼 + liquide → 𝑠𝑜𝑙𝑖𝑑𝑒 𝛽. 

 La solidification débute par la formation des cristaux de la phase 𝛼. Lorsque la 

température décroit, le nombre de ces cristaux augmente et le liquide résiduel s’enrichit en 

composé B. Lorsqu’une teneur critique est atteinte, le liquide transforme les cristaux 

𝛼 en cristaux 𝛽. C′est le cas par exemple des aciers dont la teneur en carbone à 1495°C 

conduisant à la formation de ferrite 𝛿 [2] 

 

Figure I.9 : Diagramme équilibre péritectique [8] 

 à T =T1 : Domaine monophasique ; V = 2  

 à T = T2 : Début de solidification ; biphasé ; V = 1 

 Le solide contient C1 de A et (100- C1) de B  

 à T = T3 : Biphasé ; V = 1 

 Réglé des phases ; % du Liq.=  
𝑠𝑚

𝐼𝑠
 *100 
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% du Sol. = 
𝐼𝑚 

𝐼𝑠
 *100 

 à T = T4 : Triphasés ; V = 0 

Réglé des phases applicable à T = T5 (domaine Biphasé ) ; V = 1 

Le liquide contient C2 de A et (100-C2) de B 

 à T = T6 : Biphasé ; V = 1  

Limite de solubilité de B dans A apparition de 𝛽  

 à T = T7 : V = 1 : Biphasé ; V = 1  

Réglé des phases : % de 𝛼 = 
𝑦𝑧

𝑥𝑦
 *100 ; % de 𝛽 = 

𝑥𝑧 

𝑥𝑦 
 *100 [8] 

I.6.5.Différentes formes de diagrammes d’équilibre binaires :  

Un diagramme binaire formé par deux métaux A et B sera d’ autant plus simple, à l’état 

liquide et à l’état solide, que ces deux éléments auront des propriétés physiques et chimiques 

voisines : même rayon atomique, même paramètre cristallin, même structure cristallographique 

et identité de propriétés électrochimiques associées, on obtient un diagramme à solubilité 

mutuelle complète.  

A mesure que l’élément d’addition B présente des propriétés qui s’écartent de celles du métal 

A, le diagramme binaire se complique progressivement : 

 Diminution de l’étendue des solutions solides homogènes. 

 Apparition de réactions nulles entre les phases solides et le liquide : eutectique, péritectique.  

 Formation de composé définis ou de solutions solides secondaires qui tendent à prendre les 

propriétés des éléments de base A et B, et qui ne leur sont plus isomorphe.  

Parmi les principaux types de diagrammes binaires typiques en métallurgie citons :  

 Les diagrammes à solubilité mutuelle complète. 

 Les diagrammes à solubilité limite et caractérisés par une réaction eutectique ou péritectique. 

 Les diagrammes à avec composés définis et solutions solides secondaires.   

 Les diagrammes avec démixtion à l’état liquide [5]. 
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I.7.Lecture d’un diagramme de phase ternaire  

La lecture d’un diagramme dans l’espace n’est pas commode, C’est le plus souvent des 

couvent des coupes horizontale ou verticales, ou encore les projections sur un plan horizontales 

des lignes ou surfaces remarquables, qui sont utilisées. Une phase est définie par ses 

concentration x’, y’, z’ en chacun de ses éléments A, B, C. Les concentrations peuvent 

s’exprimer en pourcentage massique ou atomique. Elles sont alors définies par la relation. 

 

x’+y’+z’=100   

    Sont en tractation, massique, ou atomique, et alors. 

x’+y’+z’=1   

 

La représentation plus commode les concentrations, dans le plan horizontal, utilise une 

grille triangulaire chaque sonnet représente un métal pur et à tout point sur un cote du triangle 

correspond un alliage binaire des métaux représentés par les deux sommets que joint chaque 

côté.  

Il existe deux façons de lire les concentrations sur cette grille. Pour un point x, par 

exemple, les compositions x’, y’, z’ en A, B, et C sont proportionnelles aux distances du point 

x aux trois côtés du triangle A B C [10]. 

 

Figure. I.10 : Système ternaire en représentation isotherme. [10] 



Chapitre I : Diagramme de phases concept et définitions 
 

15 
 

I.7.1.Types de diagrammes  

I.7.1.1.Diagramme ternaire eutectique  

 Si les trois systèmes binaires présentent des lacunes de solubilité, le diagramme ternaire 

met en évidence l’existence de trois solutions solides limitées ternaires auxquelles 

correspondent trois nappes de solidus et nappes de liquidus, ces dernières se rencontrent deux 

à deux suivent des courbes concourantes en un point qui représente un liquide en équilibre à 

une seul température avec les trois phases solides𝛼, 𝛽, et 𝛾. Dans le cas de l’eutectique (système 

illustré par la figure I.11), le point O représentant la phase liquide est situé à l’intérieur du 

triangle m1m2m 3. 

 Si on soustrait des calories au système formé par les quatre phases, la réaction suivante 

se produit : 

Liq → 𝛼 +𝛽 + 𝛾 

Elle se poursuit jusqu’à la disparition totale du liquide.  

 

Figure I.11 : Diagramme ternaire présentant une transformation .[10] 

I.7.2. Diagramme ternaire péritectique  

I.7.2.1.premier type  

Si deux parmi les trois systèmes binaires présentent un eutectique et le troisième un 

péritectique, le diagramme à résultant est conforme à la (figure I.12). Deux des trois vallées 

sont situées au-dessus du plan horizontal passant par𝜋, le troisième est toute entier au-dessous.  
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En orientant les flèches dans le sens des températures décroissantes, on obtient en 

projection la disposition de la( figure I.13). 

 

Figure I.12 : Diagramme ternaire péritectique du premier type. [10] 

Il faut donc admettre que la température de solidification d’un alliage binaire, tel que p 

ou e2 est abaissée par l’addition d’un troisième élément, tandis que celle de l’eutectique e1est 

élevée par l’addition du métal C.A la température du point 𝜋, quatre  phases sont en équilibre. 

Comme la nappe de solidus correspondant à la solution solide 𝛼 dépasse vers la droite la 

nappe de liquidus conjuguée, le point𝜋, qui représente la phase liquide. Forme un quadrilatère 

avec les points m1, m2, m 3 qui concernent les solutions solides𝛾, 𝛽, 𝛼. Si soustrait des calories 

au système forme de ces quatre phases, nous allons voir que la réaction s’écrit : 

𝑙𝑖𝑞𝜋+𝛾m3 →  𝛼m1 + 𝛽m2  

Elle se poursuit jusqu’à la disparition de l’une des deux phases régissantes. Cette réaction 

est totale pour tous les alliages dont les points figuratifs sont situés sur la droite m1m2.  

 

Figure I.13 : Projection des équilibres invariants. [10] 
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I.7.2.2.Deuxiéme type  

La réaction Liq +𝜆 → 𝛼 + 𝛽  n’a pas sa correspondante dans les systèmes binaire. Elle 

entraine une dissolution binaire dans le liquide d’une phase solide précédemment formée, mais 

elle conduit à la cristallisation simultanée de deux nouvelles phases solides. 

On rencontre dans certains alliages ternaires un point péritectique d’un type différent, 

lorsque deux des systèmes binaires présentent un péritectique (figure I.14). 

Les trois nappes de liquidus se rencontrent alors suivant trois courbes. Dont deux nappes, 

au-dessous de la température d’équilibre des quatre phases :𝜋 est situé à une température 

inférieure à celle de E, mais supérieure à celle de P1et P2. 

A chacune des nappes du liquidus correspond une nappe de solidus. Les deux nappes, de 

solidus relatives aux solutions 𝛼 et 𝛽 ont des dispositions classiques et le trièdre qui régit 

l’équilibre entre les phases Liq, 𝛼 et 𝛽 est situé au-dessus du plan horizontal𝜋. Mais la présence 

des points péritectiques P1 et P2 dans les systèmes binaires A-C et B-C entraine une disposition 

différente pour la nappe de solidus relative à solution 𝛾 

 

Figure I.14 : Diagramme ternaire péritectique de deuxième type. [10] 

Sur le plan horizontal, elle se projette suivant une surface cs1m3s3c plus grande que celle 

de la nappe de liquidus correspondante et elle la déborde vers le coté a b du triangle de référence 

(figure I.15) [10]. 

 

Figure I.15 : Projection horizontale du diagramme de la figure I.16 [10] 



 

 

 

 

 

 

 

 

 

Chapitre II : 

Le diagrammes de phases 

Fer - Carbone  



Chapitre II : Diagramme de phase Fer – Carbone  
 

18 
 

Introduction 

Dans ce deuxième chapitre nous allons d’étudier hypothétiquement le diagramme de 

phases du système Fer-carbone. Comme pas mal de métaux, le fer se cristallise dans un système 

cubique. 

On distingue plusieurs formes de fer appelées variétés allotropique du fer, qui se diffèrent par 

leur pouvoir de dissolution du carbone ou leur structure cristalline. 

Les transformations subies par le fer sont réversibles ce qui signifient qu’au refroidissement 

elles se reproduisent en sens inverses. 

L’intérêt des aciers inoxydables réside dans leurs nombreuses caractéristiques de résistance 

mécanique (dureté, résilience, résistance à la déformation).  

Toutes ces caractéristiques font de l’acier inoxydable un matériau de prédilection pour de 

multiples applications, aussi bien pour l’usage courant que pour les technologies de pointe, 

particulièrement dans les équipements ménagers, la coutellerie, l’horlogerie, les industries 

automobiles, papetières, chimiques, pharmaceutiques, pétrolières, agro-alimentaires, 

équipements maritimes, nucléaires…etc. 

Les aciers inoxydables sont des alliages métalliques à base d’acier (alliage : fer-carbone) qui 

doivent contenir au moins 10,5% de chrome et des éléments d’alliage comme le nickel, le 

molybdène, le silicium, etc. 

En raison de leur résistance à la corrosion et de leurs finis de surface de tout premier rang. 

La production d’alliages à base de fer, c’est-à-dire ceux dont le fer est le principale 

constituant, est supérieure à celle de tous les autres types de métal. 

On classe quelques-uns des aciers les plus courant selon leur concentration en carbone, à 

savoir les aciers à faible teneur en carbone, chaque groupe se subdivise en sous-groupes selon 

la concentration des autres éléments d’alliage.   

II. 1.Fer 

Le fer est le métal de base le plus important pour les alliages techniques. C’est l'élément 

chimique de numéro atomique 26, de symbole Fe. Dans la classification périodique, il se place 

dans la première série de transition entre le manganèse et le cobalt. Ses propriétés chimiques 

sont voisines de celles du cobalt. 

https://fr.wikipedia.org/wiki/%C3%89l%C3%A9ment_chimique
https://fr.wikipedia.org/wiki/%C3%89l%C3%A9ment_chimique
https://fr.wikipedia.org/wiki/Num%C3%A9ro_atomique
https://fr.wikipedia.org/wiki/Liste_des_%C3%A9l%C3%A9ments_chimiques
https://www.universalis.fr/encyclopedie/manganese/
https://www.universalis.fr/encyclopedie/cobalt/
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Il est relativement abondant dans l’écorce terrestre (4,7% en masse) sous forme d'états 

combinés dans de nombreuses roches. Le fer pur n'est pas employé dans l'industrie, les plus 

employés sont les alliages de fer avec le carbone qui sont la fonte et l'acier [9]. 

C'est un métal très ductile et malléable qu'on peut modeler sans le fondre. Les propriétés 

mécaniques dépendent de la pureté et sont en particulier grandement modifiées dans les aciers 

(alliages avec le carbone et divers éléments). Elles peuvent être très améliorées par des 

traitements thermiques. 

II.1.1.Propriétés physiques et caractéristiques mécaniques 

Le fer est métal pur de de masse 𝜌 = 7.86𝑔/𝑐𝑚 3 ferromagnétique jusqu’à 768°C, sa 

température de fusion est de 1536°C, sa dureté est de 80 HB et sa résistance à la rupture à la 

traction est R= 30 ON/mm2 [11]. 

II.2.Structure cristalline 

II.2.1.Fer 𝜶 

Cette forme existe en dessous de 906°C et cristallise dans le système cubique centré, le 

coté du cube élémentaire mesure 2.87 10-8 cm à la température 20°C. Ferromagnétique jusqu’à 

768°C, entre 768 et 906°C le fer 𝛼 n’est plus ferromagnétique [11]. 

II.2.2.Fer 𝜸 

Cette forme existe entre en 906°C et 1401°C. Le fer 𝛾 est amagnétique, dissout facilement 

le carbone et dont la solubilité croit de 0.85% de carbone à 721°C jusqu’à 1.7% à 1145°C puis 

décroît jusqu’à 0.17% à 1487°C. Il cristallise dans le système CFC, le coté du cube élémentaire 

mesure 3.63 10-8 cm à 1100°C [11]. 

II.2.3.Fer 𝜹 

Le fer 𝛿 existe de 1401°C jusqu’à la température fusion 1528°C. Il est amagnétique et 

identique à la forme 𝛼 au point de vue cristalline c.-à-d. de structure cubique centrée, le coté de 

sa maille mesure 2.93 10-8 cm et dissout un peu mieux le carbone (0.07% au maximum à 

1487°C) que le fer𝛼 [11].  

https://www.universalis.fr/encyclopedie/carbone/
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Figure II.1 : Les systèmes cubiques (CC, CFC) le fer [12].  

II.3.Principales microstructures des alliages fer-carbone  

On distingue deux catégories importantes d’alliages fer-carbone : les aciers et les fontes. 

Le domaine des aciers au carbone correspond aux alliages fer-carbone contenant moins de 1,5% 

pds de carbone. Les alliages comportant plus de 2% de carbone constituent les fontes. 

D’après les figure II.2 nous constatons qu’a une température de 727 °C et a une 

concentration en carbone de 0,8%, les diagrammes fer-C est caractérise par une transformation 

eutectoïde en carbone entre les phases 𝛾 austénite et 𝛼 (ferrite) + Fe3C (cémentite) [1]. 
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Figure II.2 : Transformation eutectoïde d’un acier [1]. 

 

 

Figure II.3 : Les diagrammes (Fer 3C) [13]. 
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La microstructure d’un acier eutectoïde, refroidi lentement, est représentée à la figure II.3. On 

distingue clairement les couches altérées de ferrite et de cémentite.  

Cette structure lamellaire, qui apparait au microscope optique aux faibles grossement sous 

un aspect chatoyant similaire à celui de la nacre, a reçu le nom perlite. [1]. 

 

 

Figure II.4 : Structure de la Perlite [1]. 

Lorsqu’on refroidit un acier de composition hypereutectoïdes (> 0,8% pds C), il se forme 

d’abord de la cémentite (Fe3C) et la perlite eutectoïde apparait ensuite. La germination de cette 

cémentite proeutectoide s’effectue préférentiellement sur les joints de grains de l’austénite car 

la germination et la croissance le long des joints de grains est nettement plus facile, ce qui 

favorise l’implantation d’une nouvelle phase.   

La perlite apparait ensuite à la température de transformation eutectoïde. En raison de la 

présence d’un réseau de carbone aux joints de grains, ces aciers sont généralement fragiles. 

Dans le cas d’un acier proeutectoide (<0,8% C), il se forme un mélange de grains de ferrite, 

solution solide de fer 𝛼 contenant moins de 0,02% C, et de grains de perlite. C’est la 

microstructure caractéristique des aciers de construction (figure II.5 (a)). 

Par des traitements thermiques et des trempes appropries, on peut induire dans les aciers 

une grande variété de microstructures comme par exemple, la martensite (figure II.5 (b)) qui 
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est obtenue par trempe de l’austénite (Fe𝛾) et qui possède une dureté et une limite élastique 

élevées. 

Les alliages contenant plus de 2% C constituent les fontes. L’addition de 4,3% pds de 

carbone au fer abaisse la température de fusion du fer de près de 400°C. Cela permet d’obtenir 

des alliages eutectiques d’un prix de revient peu élevé et dotes de propriétés intéressantes et 

convenant pour le moulage de pièces compliquées. 

Il existe trois grandes catégories de fontes : les fontes grises qui contiennent du graphite 

soit sous forme de lamelles eutectiques, ce qui les rend fragiles, soit sous forme de graphite 

sphérolithique, et les fontes blanches ou le carbone est présent à l’état précipité sous forme de 

lamelles eutectiques de carbone de fer (Fe3C). La morphologie lamellaire des fontes grises 

traditionnelles est favorisée par la présence d’impuretés comme le soufre. Les propriétés des 

fontes grises peuvent être adaptées aux besoins des applications en ajustant les teneurs en 

éléments additionnels [1].    

 

 

Figure II.5 : Exemple de deux microstructures d’un acier [1]. 

II.4.Le diagramme fer-carbone  

Ce diagramme indique l’équilibre des phases aux diverses températures et compositions 

et du fer et du carbone. 
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A températures ambiante, si on se déplace de la gauche vers la droite, on rencontre 

successivement : 

Les fers (C < 0,04%), produits malléables, obtenus à l’état pâteux, soudés, comme le fer 

puddlé naguère. 

Les aciers (C de 0,04% à 1,7%), produits malléables, obtenus au départ de la phase 

liquide.  

Les fontes (C > 1,7%), produits coulés bruts, non malléables. 

Dans le cas des fontes, la solidification peut s’effectuer suivant le diagramme fer-graphite 

ou fer-cémentite et ce en fonction de la vitesse de refroidissement et de la composition de 

l’alliage. 

Un refroidissement lent ou l’addition d’éléments graphitisant, du si par exemple, donnera 

lieu à une solidification suivant le diagramme fer-graphite. 

Un refroidissement plus rapide ou l’addition d’éléments formant des carbones de fer, tel 

le Mn, donnera lieu à une solidification suivant le diagramme fer-cémentite. 

Les divers constituants des structures sont indiqués sur les deux diagrammes ci-joints [14]. 

II.5.Diagramme d’équilibre : fer-carbone  

Le diagramme fer-carbone se présente comme la montre la figure II.6 Les lettres repères 

sont conventionnelles.  

Le liquidus est toujours représenté par la ligne A C D, le solidus par la ligne A E C F D, 

l’eutectique par le point C. 

Le carbone dont le point de fusion est supérieur à 3500°C est soluble dans le fer et peut 

se cristalliser à l’état pur en formant le graphite ou se combiner avec le fer en formant une phase 

intermétallique Fe3C appelée cémentite ou carbone de fer. 

Donc on a l’existence de deux diagrammes d’équilibres : 

 Le diagramme d’équilibre métastable Fe-Fer3C (cémentite). 

 Le diagramme d’équilibre stable fer-graphite. 
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Figue II.6 : Diagramme d’équilibre : fer-carbone [15]. 

Pour les fontes grises, on se réfère au diagramme stable Fer-carbone. Pour les fontes 

blanches et les aciers, on se réfère au diagramme métastable Fer-cémentite. 

Les diagrammes sont souvent montrés superposés car lors du refroidissement d’une fonte 

à partir de l’état liquide, il y a souvent passage du diagramme stable au diagramme 

métastable dans le domaine comportant de l’austénite [15].  
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Point Température en °C % de carbone 

A 1539 0 

B 1499 0,51 

C 1147 4,30 

D 1392 6,67 

E 1147 2,06 

F 1147 6,67 

G 910 0 

H 1499 0,10 

I 1499 0,16 

K 723 6,67 

M 760 0 

N 1392 0 

P 727 0,02 

Q 20 0,006 

C’ 1147 4,30 

E’ 1153 2,03 

S’ 727 0,69 

 

Tableau II.1 : Les points caractéristiques du diagramme fer-carbone et métastable [15]. 

II.6.Description du diagramme (figure II.6) 

II.6.1.Les lignes 

ACD : Liquidus. 

AEF : Solidus. 

ECF : Eutectiques (palier). 

A1(723°C) (PK) : Eutectoide (palier), Au-dessus de cette teméraure la phaseperlite n’existe 

plus. 

A3 : Elle précise la fin de la transformation de la ferrite en austénite ; la ferrite n’existe plus 

au-dessus de cette ligne. 
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Acm : Elle indique la fin de la dissolution, aux normes internationales. Après dissociation, de 

la cémentite dans l’austénite lorsque celle-ci existe. 

II.6.2.Les phases 

Austénite : C’est une solution de carbone dans le fer γ Cette solution solide occupe seule le 

domaine AESG (ferγ) et coexiste avec d’autres phases dans les domaines adjacents : 

-avec la ferrite (GSP) 

-avec la cémentite (ESKF) 

Ferrite : C’est une solution solide de carbone dans le ferα. Cette solution occupe seule le 

domaine GPQ et coexiste avec l’austénite dans le domaine GPS et avec la cémentite PQRK. 

Cémentite : C’est une combinaison chimiquement définie (carbone de fer à 6,67% de 

carbone). La cémentite coexiste avec l’austénite dans le domaine (SEFK) et avec la ferrite 

dans le domaine (PQRK). 

II.6.3.Les points particuliers 

 

Figure. II.7 : Diagramme Fer-Carbone [16]. 
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Point eutectiques  

Point C 

A 4,3% de carbone  

A 1145°C, le liquide eutectique à 4,3% de carbone se solidifie en 

donnant la lédéburite (eutectique formé de Cémentite et d’austénite à 

1,7%C). La règle des segments inverses donne le rapport de masses 

constituantes. 

 % Austénite = 
CF

EF
 100 = 

6,7−4,3

6,7−1,7 
. 100 

% Cémentite = 
𝐶𝐹

𝐸𝐹
100 =  

4,3−1,7 

6,7−1,7 
. 100 

Point eutectoïde 

Point S 

à 0,83% de carbone  

Au point S, l’austénite de composition 0,83% de carbone est 

convertie en perlite eutectoïde formée de ferrite et de cémentite dans 

des proportions : 

% Cémentite = 
SF

EF
 100 =  

0,83−0

6,7−0 
. 100 

% Ferrite = 
SP

PK
 100 = 

6,7−0,85

6,7−0 
. 100 

 

II.7.Généralités sur les aciers inoxydables  

Les aciers inoxydables sont des alliages métalliques à base d’acier (alliage : fer-carbone) 

qui doivent contenir au moins 10,5% de chrome et des éléments d’alliage comme le nickel, le 

molybdène, le silicium, etc. selon le pourcentage de ces éléments, la structure d’acier en 

condition d’emploi sera martensitique, duplex, austénitique ou ferritiques. La principale 

propriété des aciers inoxydables est leur excellente résistance à la corrosion. 

Cette propriété donne au matériau une durée de vie quasi exceptionnelle dans la très 

grande majorité des milieux. A cette propriété fondamentale, s’ajoutent les caractéristiques 

mécaniques intéressantes comme la résistance mécanique, la ductité et la ténacité [16]. 

II.8.Classification des aciers  

On peut classer les aciers selon leur composition chimique ou se selon leur domaine 

d’utilisation. C’est ces dernières classifications qui nous permettent de considérer les quatre 

familles suivantes [17]. 

 II.8.1. Les aciers au carbone d’usage général  

Les aciers au carbone d’usage général, utilisés tels quels, sans traitement ultérieur, 

constituent environ 85% de la production des aciers. Ce sont des matériaux produits en très 

grande quantité et dont le prix est relativement bas. Outre le carbone, ces aciers contiennent des 

éléments d’addition (manganèse, silicium) et des impuretés (soufre et phosphore) dont la 

présence découle de leur mode d’élaboration [17]. 
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II.8.2.Les aciers de traitements thermiques  

Les aciers alliés ou non alliés de traitements thermiques sont définis en fonction de leur 

composition. La composition chimique de ces aciers permet de déterminer les traitements qu’on 

peut leur appliquer en fonction des propriétés recherchées.  

  Aciers non alliés : Ces aciers sont, en fait, intermédiaires entre les d’usage général de type 

A et les aciers fins de XC ; on peut leur faire subir un traitement thermique mais les 

caractéristiques mécaniques obtenues peuvent être assez variables d’un lot à l’autre et même 

à l’intérieur d’un même lot.  

 Aciers alliés : On distingue deux grandes catégories d’aciers alliés :  

 Aciers faiblement alliés : Ce sont des aciers dans lesquels aucun élément d’addition 

n’atteint la de 5%. 

 Aciers fortement alliés : Dans ces aciers, au moins un élément d’addition atteint la 

teneur supérieure ou égale à 5%. 

II.8.3.Aciers à outils  

Sont des aciers utilisés pour la fabrication d’outils mécanique tels que les mèches, outils 

de coupe, cisailles, marteaux, burins…..etc. Les caractéristiques d’utilisation des aciers à outils 

sont semblables à celles des aciers alliés, mais elles exigent l’amélioration d’un certain nombre 

de propriétés : la trempabilité ; la tenue chaud, la ténacité, la résistance et la résistance aux 

chocs thermiques.  

II.8.4.Aciers inoxydables  

Les aciers inoxydables comprennent un ensemble de familles d’alliages à base de fer dont 

la principale propriété est la résistance à la corrosion généralisée. Toutefois, bien qu’on les 

qualifie d’inoxydables, ces aciers ne sont pas dans tous les cas totalement exempts d’une 

possibilité de corrosion. Le chrome est l’élément essentiel qui, à des teneurs supérieures à 

environ 12%, rend l’acier inoxydable en favorisant, en milieu oxydant, la formation d’un film 

passif sa surface [17]. 

II.9.Les aciers au carbone  

On appelle acier un alliage de fer et de carbone dont la teneur en carbone est inférieure à 

2% massique. Cette teneur limite vient de la limite de solubilité de carbone, à haute température, 

dans la phase cubique à faces centrées (cfc) du fer, appelée austénite. Des éléments d’alliages 
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sont généralement ajoutés à un alliage Fe-C afin d’améliorer les caractéristiques mécaniques et 

les propriétés des aciers. 

Le diagramme de phase de l’alliage binaire Fe-C est donné sur la figure II.8  

 

Figure II.8 : Diagramme de phases de l’alliage binaire Fe-C [18]. 

Il apparait que pour une concentration précise de carbone dans l’acier, à savoir 0,77% 

massique, le passage de la phase 𝛼 + Fe3C à la phase austénitique 𝛾 se produit de manière 

isotherme. Il s’agit alors d’une transformation eutectoïde. Les domaines de transformations 

traversés pour des teneurs inférieure et supérieure à 0,77% sont alors différents. La convention 

suivante a été adoptée : 

 Un acier de teneur en carbone égale à 0,77%, massique acier eutectoïde. 

 Un acier de teneur inférieure à 0,77%, est appelé acier hypereutectoïdes. 

 Un acier dont la teneur est supérieur à 0,77%, est qualifié d’acier hypereutectoïdes. 

Les alliages auxquels nous sommes intéressés lors de cette étude ont une teneur en 

carbone avoisinant les 0,6%. Il s’agit donc d’aciers de type hypereutectoïde. 

 Les transformations de phases à l’état solide peuvent principalement être gouvernées par 

deux modes différents, à savoir la diffusion ou un mouvement coordonné d’atomes, sans 

diffusion. Dans le cas des aciers, au cours du refroidissement, la phase austénitique n’est plus 
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stable. La vitesse de refroidissement modifie la nature des transformations de phase qui peuvent 

se produire : 

Si la vitesse de refroidissement est faible, on se trouve dans un état proche de l’équilibre. 

La diffusion du carbone est alors possible. Le refroidissement de phase austénitique va ainsi 

conduire à la formation d’un mélange 𝛼 + Fe3C. Pour un acier à 0,6% de carbone, la structure 

finale obtenue sera une structure ferrito-perlitique. 

 Si la vitesse de refroidissement est rapide. Le carbone ne peut pas diffuser et se retrouve 

piégé dans la maille. Cette transformation est hors d’équilibre et conduit à la formation d’une 

phase métastable : la martensite. 

Pour des vitesses de refroidissement, les structures bainitiques sont observées [18]. 

II.10. Les principales familles d’aciers inoxydables  

Les aciers inoxydables sont classés en 4 grandes familles en fonction de leur composition 

et de leur structure cristallographique. On distingue les aciers ferritiques, les aciers 

martensitiques, les aciers austénitiques et les aciers austéno-ferritiques. Le tableau 01résume 

les principaux composants chimiques et les fourchettes de composition de ces différentes 

familles d’aciers inoxydables [16]. 

Catégorie 

d’acier 

Composition (% pds) 

C Cr Ni Mo Autres 

Ferritiques < 0.1 13 - 30 0 - 5 < 5 Ti 

Martensitique 0.05 – 1.2 12 - 18 < 7 - - 

Austénitique < 0.2 16 - 35 7 - 35 < 6 N, Cu, Ti 

Austénitique < 0.05 18 – 27 4 – 7 < 4 N (< 0.3) 

Tableau 2 : Fourchettes de compositions des différentes familles d’aciers 

inoxydables [19]. 

II.11.Les différentes phases des aciers  

L’acier est un mélange formé par la dissolution de carbone dans le réseau 

métallique du fer. Il existe différentes phases des aciers qui présentent chacune des 

propriétés différentes. Ces propriétés son liées notamment à la position du carbone 

dans la structure métallique du fer (cc) ou (cfc). Et leur concentration 
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essentiellement en carbone mais aussi d’autres éléments d’alliage), et de la 

température. De là qu’on parle du diagramme binaire fer-carbone [15]. 

II.12.Principales applications des différentes familles  

A partir des remarques précédentes, on comprendra mieux les principales 

applications des grandes familles d’inoxydables. Bien entendu, nous nous 

limiterons à en donner, dans chaque cas, quelques exemples typiques. 

 Inoxydables ferritiques 

1. Groupe 1 : caractéristiques : épaisseur limitée, résistance à la corrosion limitée. 

Applications : automobile (décoration, pots d’échappement, pots catalytiques), ameublement, 

bâtiment, tubes minces (sucreries), containers, etc. 

2. Groupe 2 : caractéristiques : épaisseur limitée, bonne résistance à la corrosion. 

Applications : électroménager, cuisines industrielles, éviers, ballons d’eau chaude, matériel de 

laiterie, etc. 

 Inoxydables martensitiques  

1. Groupe 1 : caractéristiques : résistance à la corrosion limitée, mise en œuvre facile. 

Applications : pièces mécaniques diverses, vannes, robines, visserie et boulonnerie inox, etc. 

2. Groupe 2 : caractéristiques : résistance à la corrosion moyenne, dureté élevée. 

Applications : ménagères inox (couteaux, cuillers, fourchettes, divers), platerie, etc. 

3. Groupe 3 : caractéristiques : dureté très élevée. 

Applications : outils chirurgicaux, outillage. 

4. Groupe 4 : caractéristiques : bonne résistance à la corrosion, mise en œuvre aisée. 

Applications : grosses pièces industrielles forgées ou moulées (vannes, pompes, turbines 

hydrauliques Kaplan ou Pelton, axe d’hélice, marine, tubes de périscope, etc.). 

 Aciers inoxydables austénitiques  
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Applications : chaudronnerie lourde, industrie chimique, pétrochimie, industrie pétrolière, 

industrie, nucléaire, retraitement des combustibles, énergie, gaz liquéfiés (cryogénie), 

appareillage scientifique, électronique. 

 Austéno-ferritiques  

Caractéristiques : utilisation <200-250°C, bonne résistance à la CST. 

Applications : chaudronnerie lourde, industrie chimique, industrie papetière, industrie 

pétrolière, etc. 

 Aciers inoxydables à hautes caractéristiques : 

Applications : domaines aéronautique, spatial et militaire. [20] 

II.13.Domaines d’utilisations des aciers inoxydables  

 En raison de leur résistance à la corrosion et de leurs finis de surface de tout premier rang, 

les aciers inoxydables jouent un rôle prépondérant pour l’équipement des particuliers et des 

collectivités, dans le bâtiment, et la décoration, l’industrie des transports et les industries 

pétrolières, agroalimentaires, pharmaceutiques et chimiques, devient de plus en plus un produit 

de grande consommation. Parallèlement, il s’impose comme un matériau de base pour la 

fabrication des équipements industriels qui doivent résister à des sollicitations mécaniques, 

chimiques et thermiques de plus en plus sévères. 

Les aciers inoxydables constituent d’une une grande famille d’alliages métalliques qui ont tous 

en commun de posséder du fer et du chrome. Suivant leur teneur en chrome et les traitements 

métallurgiques qu’ils ont subis, ils présentent une large gamme de propriétés. Dans la suite, 

nous allons brièvement décrire les différentes familles d’aciers inoxydables [16]. 
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Classe d’acier 

inoxydable 
Martesique Ferritiques Austénitique 

Austéno-ferritiques 

(duplex) 

Composition 

chimique 

C%≤ 1,2 

12≤ Cr%≤ 18 

Ni%≤ 7 

Mo%≤ 3 

Alliage Fe-Cr 

Ou Fe-Cr-Mo 

11≤ Cr%≤ 30 

Aucune addition 

En Nickel 

 

17≤ 𝐶𝑟% ≤ 18 

7≤ Ni%≤14 

C%≤ 0,05 

Mo%≤ 3 

 

20≤Cr% ≤25 

4≤Ni%≤7 

Mo%≤ 4 

N%≤ 0,3 

Propriétés 

mécaniques 

-Dureté élevée 

-Elasticité 

Elevée 

-Bonne résistance à la 

corrosion 

-Elasticité 

assez bonne 

-Dureté faible. 

-Bonne résistance à la 

Rupture ; 

-Elasticité faible 

-Ductilité et 

Ténacité 

Exceptionnelles ; 

-Bonne résistance 

à la corrosion. 

-Haute résistance à 

la rupture : 

Elasticité très 

élevée : 

Excellentes ductilité 

Et ténacité 

-la résistance à la 

Corrosion. 

 

Propriétés 

physiques 

-Faible dilatation  

Thermique. 

-Faible dilatation 

Thermique ; 

-Alliages 

ferromagnétiques. 

-Haute dilatation 

Thermique.  

-Bonne 

dilatation thermique 

-Haute résistivité 

Electrique. 

Tableau 3 : Les familles d’acier inoxydables [16]. 

II.14.Soudage des aciers inoxydables  

A. Les structures ferriques :  

Identification par leurs propriétiques magnétiques, sont thermiquement fragile donc 

difficilement soudables. 

B. Les structures austénique :  

Sont amagnétique et très stables en régime thermique varié. Les inoxydables de cette 

catégorie sont considérés comme bien soudable. 

Réfractaires : 

Magnétiques ou amagnétique, certains sont soudables précautions particulières, d’autres 

exigent des traitements thermiques plus ou moins applicables sur machine. [21], le tableau N°04 

contient les paramètres soudage par points de l’acier inoxydable 304L [22]. 
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EP 

(mm) 

∅ Face active 

Electrode (mm) 

Effort 

daN 

Temps de 

soudage 

Courant de 

Soudage (KA) 

∅ du 

Noyau (mm) 

Temps de 

forgeage 

0,5 

0,6 

0,8 

1 

1,2 

1,5 

1,8 

2 

2,4 

2,5 

3 

3,2 à 4 

4 à 4,2 

4,5 à 4,8 

5 

5,4 

6 à 6,2 

6,7 à 6,9 

7 à 7,2 

7,2 à 7,5 

7,5 à 8 

9 

180 à 230 

190 à 240 

250 à 300 

300 à 400 

450 à 500 

500 à 600 

850 

900 

1000 

1200 

1500 

2 à 3 

4 à 5 

5 à 6 

7 

8 à 9 

10 

11 

12 

13 

14 

16 

4 à 5 

4,5 à 5,2 

5,5 à 6 

6,8 à 7 

8 

9 à 10 

12 

14 

15 

16 

17,5 à 18 

3 à 4 

3,5 à 4 

4 

4,8 

5 

6 

7 

8 

9 

6 

7 

8 

10 

10 

16 

20 

22 

24 

25 

25 

30 

40 

 

Tableau 4 : Paramètres de soudage par points de l’acier inoxydable 304L [22]. 

II.14.1.Transformations isothermes  

L’expérience prouve que la constitution d’équilibre d’un acier n’est acquise si la 

température varie assez lentement pour donner aux transformations le temps de s’effectuer. Dans 

le cas contraire, non seulement les transformations pourront ne pas avoir lieu du tout ou au 

contraire se faire incomplètement. 

On obtient dans ces deux cas de nouveaux constituants que le diagramme d’équilibre ne 

peut indiquer, ils correspondent à des états hors d’équilibre ou états trempés. Si un acier à structure 

austénitique est obtenu par chauffage à une température à AC3, est sur fusionne à une température 

inférieure à A1, l’austénite acquiert un état métastable et subit des transformations. Pour décrire 

l’allure cinétique des transformations, on utilise le diagramme TTT (figure II.9). 
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Figure II.9 : Diagramme TTT [1]. 

I.14.2.Transformation perlitique  

Pour des températures de transformation entre 720°C et 450°C (phase perlitique), débute la 

transformation par la formation des premiers germes de cémentite sur les joints des cristaux de 

l’austénite, ces germes se développent à l’intérieur des cristaux 𝛾 et le voisinage des cristaux de 

cémentite s’appauvrit en carbone et se fustige en ferrite𝛼. La solubilité du carbone dans la ferrite 

est très faible, ce qui conduit à la précipitation du carbone se trouvant dans la ferrite dans le 

domaine de l’austénite voisin et ce qui donne la formation de la perlite (Fe𝛼 + cémentite). La 

figure II.10 donne les différentes étapes de la formation de la perlite (transformation austénite en 

perlite). 

La transformation perlite a le caractère de la diffusion, à première étape, elle est caractérisée 

par l’apparition des germes de cémentite sur les joints des grains de l’austénite. 

La deuxième étape montre le développement des germes de la cémentite tout en provoquant 

l’appauvrissement des places voisines en carbone et en se transformant en ferrite et enfin la 

troisième étape c’est la formation de la perlite.  

Une petite surfusion donne un petit nombre de germes de cémentite avec des lamelles 

épaisses, mais quand la vitesse est assez considérable, c’est-à-dire le degré de surfusion est élevé, 
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dans ce cas le nombre de grains est plus grand et les lamelles de la perlite sont plus fines c’est-à-

dire on a le constituant Sorbite ou Troostite.  

La perlite, la Sorbite et la Troostite se distinguent l’une de l’autre par l’épaisseur des 

lamelles. Dans la perlite, leur dureté est aussi différente [1]. 

 

Figure II.10 : Transformation perlitique [1]. 

II.14.3.Transformation intermédiaire (bainitiques)  

Comme pour la transformation perlitique, l’austénite se décompose en deux phases par 

diffusion, mais cette diffusion ne se produit pas jusqu’à la fin et la phase de la ferrite, dans ce cas, 

elle représente une solution solide de carbone dans le fer𝛼, mais elle est sursaturée lors de la 

transformation bainitiques. On peut arriver au fait qu’il reste une quantité de l’austénite résiduelle, 

qui peut se transformer en martensite lors d’un refroidissement ultérieur. 

Pour des surfusions très élevées, entre 400°C et le point Ms (transformation bainitiques) se 

forme la bainite à partir l’austénite. Les températures très basses empêchent la diffusion du 

carbone dans l’austénite (elle est pratiquement arrêtée), le début de la transformation augmente. 

La représentation schématique de la formation de la bainite (transformation austénite bainite) est 

donnée par la figure II.11 [1]. 

 

Figure II.11 : Transformation bainitiques [1]. 
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II.14.4.Transformation martesique  

C’est au-dessous d’une température d’environ 180°C que se forme la cémentite à partir de 

l’austénite sur fusionnée. Lorsque la température de l’austénite sur fusionnée diminue jusqu’à 

environ T 180°C, ou même plus bas, le processus de diffusion est complétement arrêté et une 

transformation sans diffusion se produit, elle est appelée transformation martensitique.  

La martensite est une solution solide de carbone dans le fer 𝛼 mais très saturée, son réseau 

cristallin est très distorse (déformé). La transformation martensitique se produit sans déplacement 

des atomes de carbone, seulement les atomes de fer qui se déplacent à une distance plus petite 

que la distance interatomique, cette transformation se produit très vite. 

Les points de début et fin de transformation dépendent du pourcentage de carbone, avec 

l’augmentation du %C, les points Mf et Ms diminuent.  

Pour des refroidissements continus, les diagrammes TTT ne correspondent plus à cette 

réalité, mais il existe d’autres types de diagramme appelés diagramme de surfusion. 

La figure II.12 : nous donne une idée de l’influence de la vitesse de refroidissement sur les 

différentes transformations de l’austénite [1].  

 

Figure II.12 : Effet de la vitesse refroidissement sur les transformations de l’austénite [1]. 

II.15.Les transformations de phase les aciers  

II.15.1.Transformations allotropiques dans les aciers bas carbones micro-alliés  

 Les aciers micro-alliés à basse teneur en carbone présentent en quasi-équilibre les mêmes 

types de transformations allotropiques à partir de l’austénite que le fer pur. En effet, fer est un 

élément qui possède plusieurs formes allotropiques, c’est -à-dire que selon les conditions en 
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température et en pression, différentes structures cristallines sont observée. Ainsi à la pression 

atmosphérique (figure II.13) : 

- Entre 1538°C et 1394°C d’une part et 912°C et -273°C d’autre part, la structure cristalline du 

fer pur est cubique centrée (CC), cette structure n’est pas compacte, et la forme cristalline du 

fer est dite fer 𝛿 et fer 𝛼 respectivement. Dans les aciers, la phase associée est nommée ferrite.  

- Entre 1394°C et 912°C, la structure cristalline du fer pur est cubique à faces centrées (CFC), 

cette structure compacte et cette forme est dite fer 𝛾.  La phase associée est nommée austénite 

dans les aciers [20]. 

 

Figure II.13. : Diagramme d’équilibre métastable Fer-Cémentite [26]. 

II.15.2.Types de transformations de la phase austénique au refroidissement  

Dans les aciers, les transformations de phase au refroidissement à partir de la phase 

austénitique sont de deux : les transformations di fusionnelles conduisant généralement à la 

formation de ferrite et de carbures et les transformations displacives ou martensitiques. Le 

mécanisme physique mis en jeu lors de la formation de ces nouvelles phases dépend de la 

température à laquelle la transformation est amorcée et celle-ci est fonction de la vitesse de 

refroidissement : plus la vitesse de refroidissement est élevée, plus la température de 

transformation est basse. 
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Par ailleurs, les courbes TTT de la plupart des aciers présentent une large gamme de 

températures intermédiaires dans laquelle ne se forment ni ferrite (+ perlite) ni martensite. A la 

place peuvent se former des structures de morphologie aciculaire, communément appelées 

« bainite » (voir figure II. 14). 

 

Figure II.14 : Transformations structurales dans les aciers (Schéma d’un diagramme TRC 

type d’un acier bas carbone avec une courbe en C distincte pour la transformation 

bainitiques) [23]. 

II.16.Acier  

La production d’alliages à base de fer, c’est-à-dire ceux dont le fer est le principale 

constituant, est supérieure à celle de tous les autres types de métal. 

Les aciers sont des alliages fer-carbone qui comportent aussi une concentration appréciable 

d’autres éléments, il existe des milliers d’alliages de ce type dont la composition est différente, 

de même que les traitements qu’ils ont subis, les propriétés mécaniques dépendent de la teneur 

en carbone, laquelle est normalement inférieure à 1%m.  

On classe quelques-uns des aciers les plus courants selon leur concentration en carbone, à 

savoir les aciers à faible teneur en carbone, chaque groupe se subdivise en sous-groupes selon la 

concentration des autres éléments d’alliage, les aciers au carbone ordinaires ne contiennent que 

des concentrations résiduelles en impuretés autres que le carbone et un peu de manganèse. Quant 

aux aciers alliés, on leur ajoute davantage d’éléments d’alliage en concentration précises. [24].  
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Figure II.15 : Classification des matériaux [24] 

II.16.1.Aciers à moyenne teneur en carbone  

La concentration en carbone de ces aciers varie de 0,25%m à 0,60%m, leurs propriétés 

mécaniques s’améliorent par austénitisation, trempe, puis revenu, on les utilise le plus souvent à 

l’état revenu, auquel cas ils ont une microstructure de martensite revenue. 

Les aciers à moyenne teneur en carbone ont une faible trempabilité et leur traitement 

thermique n’est efficace que si leur si leur section est très mince et si la vitesse de refroidissement 

est très élevée, l’ajout de chrome (Cr), de nickel (Ni) ou de molybdène (Mn) facilite. L’application 

de traitements thermiques à ces alliages et offre un large éventail de combinaisons résistance 

ductilité, les traitements thermiques produisent des aciers plus résistants que les aciers au carbone 

ordinaires, mais d’une ductilité et d’une ténacité moindres, parmi les pièces faites d’acier à 

moyenne teneur en carbone, mentionnons les roues de de train et les voies ferrées, les engrenages, 

les vilebrequins ainsi que d’autres pièces de machine et des composants structuraux alliant haute 

résistance à l’usure et ténacité [24]. 

II.16.2.Aciers de haute teneur en carbone 

 Un acier de haute teneur en carbone sera employé pour sa grande dureté alors qu’un acier 

de teneur plus faible est moins dur et plus malléable, il contient généralement de petites quantités 
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d’autres éléments que le fer et le carbone, incorporés, volontairement ou non, au cours de son 

élaboration, on peut également y ajouter des quantités plus importantes d’éléments d’alliage ; il 

est considéré alors comme un acier allié [24]. 

II.17. Caractéristiques fondamentales des aciers 

 Le fer est un élément chimique. Il est assez difficile d’obtenir du fer très pur, mais ce n’est 

pas gênant car les propriétés d’emploi du fer deviennent bien plus intéressantes et variées 

lorsqu’on lui ajoute des éléments d’alliage judicieusement choisis et dosés et ces éléments 

peuvent être : 

- Eléments alphagénes et gammagénes ; 

- Graphitisant ou carburières. 

Les éléments d’addition ont des solubilités très différentes dans ces deux variétés. Ce fait 

entraine l’existence de domaine de transformations très différentes en présence des éléments 

d’addition (figure II.6). Dans le fer pur, le passage de fer 𝛼 au fer 𝛾 se produit à une température 

définie. La présence d’un élément d’addition entraine l’apparition d’un domaine plus au moins 

étroit dans lequel les deux variétés allotropiques peuvent coexister en équilibre [22]. 

 

Figure II.16 : Evolution des domaines d’existence des variétés allotropiques du fer en fonction 

des additions [25]. 
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III.1.Introduction 

Dans ce chapitre nous allons essayer en premier temps de ce familiarisé avec le 

logiciel ImageJ. Pour commencer nous allons le présenter en suit on va essayer de 

l’appliquer sur des échantillons d’acier. 

L’ImageJ c’est le fascinant logiciel de traitement et d’analyse d’image scientifique, 

autant par ses fonctions intrinsèques que par le riche ensemble de fonctions délivrées 

sous forme de plugins. Derrière une interface quelque peu désuète, ImageJ cache des 

fonctions simples d’accès, directes et puissantes pour l’analyse d’image. Ce logiciel est 

utilisable dans tous les domaines scientifiques, bien qu’un accent particulier soit mis 

sur l’imagerie biomédicale. 

ImageJ est un fascinant logiciel de traitement d’images et d’analyse d’image 

scientifique, autant par ses fonctions intrinsèques que par le riche ensemble de fonctions 

délivrées sous forme de plugins. Derrière une interface quelque peu désuète, ImageJ 

cache des fonctions simples d’accès, directes et puissantes pour l’analyse d’image. Ce 

logiciel s’utilise dans tous les domaines scientifiques, bien qu’un accent particulier soit 

mis sur l’imagerie biomédicale. 

Dans un esprit totalement altruiste, ImageJ a été déposé dans le domaine public. 

ImageJ possède un mécanisme simple pour la création de plugins. Des centaines de 

traiteurs d’images, de programmeurs, de chercheurs avertis et d’utilisateurs un peu 

débrouillards ont réalisé des plugins et ont mis leurs contributions en ligne. [26] 

ImageJ est un logiciel libre, qui fonctionne aussi bien sous plate-forme Windows, 

Mac ou Linux Initialement développé pour analyser des images médicales par le 

National Instute of Heath, c’est un outil très versatile pour effectuer des mesures 

physiques à partir d’images ou de vidéos. Vous pouvez le télécharger gratuitement sur 

le site : http//rsb.info.nih.gov. De multiples macros, plugins et exemples sont 

également disponibles sur ce site. 

Sans chercher à décrire toutes les possibilités de ce logiciel, nous présentons ici 

quelques éléments qui pourront être utiles pour les TPs ou tutorats. [27] 

 

III.2.Installation 



Chapitre III : ImageJ Présentation et teste d’application sur des échantillons d’acier 

 

44 
 

Image j est un logiciel d'analyse d'images libre de droit développé par Wayne 

Rasband du National Institutes of Heath. Il est téléchargeable gratuitement sur le site : 

http://rsb.info.nih.gov/ij/download.html où il faut choisir la plateforme utilisée et en 32 

ou 64bits selon l'ordinateur utilisé. Si cela est possible, toujours préférer la version en 

64 bits qui permet d'ouvrir des fichiers beaucoup plus lourds. Par défaut, Image J 

s'installe dans le dossier C:/Program Files/ImageJ/ 

Il est nécessaire de régulièrement mettre à jour ImageJ dans Help/ Update 

ImageJ afin de corriger d'éventuels bugs et d'ajouter de nouvelles fonctions. 

Vous pouvez aussi installer de nouveaux plugins. Ils peuvent être trouvés sur le site 

d'ImageJ (http://rsbweb.nih.gov/ij/plugins/index.html) et sur les sites de développeurs 

en cherchant sur Google. Enregistrez ces plugins dans le dossier 

Program Files\ImageJ\plugins. 

Re-démarrez ensuite ImageJ et votre plugin est automatiquement installé. 

La fenêtre ImageJ contient une barre de menu standard, une barre d'outils et une barre 

d'état renseignant sur les coordonnées et les caractéristiques du pixel survolé par la 

souris et sur l'avancement des tâches en cours. 

 

Il est possible de modifier la mémoire allouée à ImageJ afin d'ouvrir de gros fichiers 

dans Edit/ Options/ Memory & Threads. Cependant, elle est automatiquement ajustée 

au démarrage d'ImageJ et optimisée pour votre système. Changer manuellement la 

mémoire maximum à une valeur supérieur à 

70% de la mémoire totale induira une lenteur d'exécution des tâches demandées. 

Starck : Sous ImageJ, un stack est une image à 4 dimensions : x, y, c + z ou t. 

Hyperstack : Sous imageJ, un Hyperstack est une image à 5 dimensions ou plus : 
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x, y, z, c, t. Il n'est pas simple de représenter ce type d'image compte tenu du nombre 

important de dimensions. 

ImageJ offre la possibilité de manipuler facilement ce type d'images en plaçant sous 

l'image des barres de défilement qui permettent de sélectionner le canal "c", la tranche 

"z" et le point de temps "t" à afficher : 

 

Figure III.1 : Exemple d’hyperstack [28]. 

B- Ouverture de fichiers 

Pour pouvoir ouvrir vos images, il suffit d'aller dans File/Open ou de faire un 

glisser/ déposer de votre image sur la barre d'imageJ. 

Pour pouvoir ouvrir vos images acquises en format constructeur de manière optimale, 

il vous faut utiliser le plugin Loci. Pour cela, téléchargez-le  

(www.loci.wisc.edu/software/bio-formats) et installez le dans le dossier Program 

Files\ImageJ\plugins. 

Une fois re-demarré ImageJ, Loci se trouve dans le menu Plugin/ Bio Format 
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Importer. 

Vous pouvez alors choisir d'ouvrir vos fichiers selon différentes options : 

- Autoscale : ajuste automatiquement l'affichage de l'image (brillance et 

Contraste) 

- Display metadata : pour afficher dans un fichier séparé les métadonnées de l'image 

- Display ROI : ajoute les ROIs (Région Of Intérêts : Région d'intérêt) présentes dans 

l'image au ROI manager 

- Use Virtual stack : Permet de visualiser un fichier de taille supérieur à la mémoire 

disponible 

- Specify range for each series : ouvre un sous ensemble du fichier selon les 

paramètres choisis. 

- Croup on import : ouvre une partie de l'image selon les coordonnées choisies. 

- Split channes : les canaux sont ouverts dans des stacks séparés  

- Split focal planes : les plans sont ouverts dans des stacks séparés 

- Split time points : les temps sont ouverts dans des stacks séparés [28]. 
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Si l'image ouverte a été sauvegardée dans le format du logiciel d'acquisition, elle est 

alors automatiquement calibrée et le bandeau donne plusieurs informations [28]. 

 

Figure III.2 : L'image ouverte [28]. 

III.3.Image J 

1) Ouvrir une image : File _ Open1 

Sélectionner l'image à laquelle on veut intégrer une barre d'échelle 

 

2) Mise à l'échelle de l'image : Analyse _ set scale  
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Distance in pixel = 1 

distance connue = x 

Ratio = 1 

Unité = μm (pour micromètre) 

Cocher global (pour appliquer à toutes les images ouvertes) 

OK 

3) Affichage de la barre d'échelle sur l'image : Analyse _ Tools _ Scale Bar 

Width in μm : taille de la barre d'échelle sur l'image. 

Height in pixel : largeur de la barre d'échelle. 

Color : Couleur de la barre d'échelle (dans le cas d'une image RGB). 

Location : Position de la barre d'échelle dans l'image. [29]. 
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ATTENTION : Une fois la barre d'échelle intégrée à l'image il n'est plus possible de 

la retirer. 

III.4.Que fait ImageJ 

Passer en revue toutes les fonctionnalités déborderait largement de la carde de cet 

article. 

En effet, ImageJ dispose d’un catalogue complet d’opérations standards de traitement 

des images. Si jamais une opération venait à manquer, alors on trouvera bien quelqu’un 

qui l’’aura programmée et mise à disposition. [30].soit par sec fonctions natives (y 

compris les formats médicaux Dicom), soit en utilisant un plugin spécialisé comme la 

très complète librairie Bio Formats (licence GPL) [31]. Il y a même des reverse 

engineering plugins qui permettent de décoder certains formats de fichiers propriétaires, 

tenus secrets pour des raisons mercantile. 
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Figure III .3: Illustration de la fonction Image Calculator. L’image résultat (à 

droite) est la soustraction des deux images (ou gauche et au centre) prises à quelques 

secondes d’intervalle. Cette soustraction met clairement en évidence les objets en 

mouvement. ([32] 

ImageJ possède une large panoplie d’opérations usuelles de traitement d’images 

dites pointwise et de transformation d’histogramme. Dans ce cadre, une fonction Image 

Calculator qui au premier abord semble banale s’avère en pratique très utile et intuitive. 

Elle permet de combiner des images pixel-à-pixel avec des opérations, exactement 

comme on pourra le faire avec des nombres (figure III.3). 

Les opérations de filtres dans le domaine spatial font partie de l’ImageJ, aussi bien les 

filtres linéaires classiques que les filtres morphologiques. Pour la segmentation 

d’images, la fonction préférée des utilisateurs est Analyzer Particules qui après 

binarisation, va extraire tous les composants connexes (objet) d’une image et 

caractériser leurs formes et leurs dimensions. 

Un avantage de l’ImageJ est la possibilité d’appliquer certains traitements dans une 

troisième dimension. Celle-ci peut indifféremment représenter le temps pour les 

séquences d’images (films), ou une dimension spatiale supplémentaire (z-stack) pour 

les données volumétriques qui sont courantes en imagerie biomédicale. [32] 

III.5.Comptage d'objets en 2D : Plugin Analyze particle 

Segmentation et quantification d'objets sur une même image 

- Si besoin, soustraire le fond (Procès / Substrat background). Plus le radius est petit, 

plus la soustraction sera importante 
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- Faites un seuillage (image/ Adjust/ Threshold), ne pas cliquer sur Apply. 

- Dans Analyze/ Set measurements, choisissez quelles informations vous souhaitez 

obtenir. 

- Lancez le plugin Analyze particle (Analyze/ Analyze particle) : 

Ce plugin réalise une analyse en composantes connexes. En effet, chacun des pixels 

constitutifs des objets va se voir attribuer une étiquette. Le processus démarre avec le 

pixel en haut à gauche de l'image et se poursuit par la lecture des pixels ligne par ligne, 

de gauche à droite. Dès qu'un pixel objet est rencontré, les pixels adjacents (pixels 

touchants en arrière et en haut) sont consultés afin de savoir s'ils disposent déjà d'une 

étiquette. Si c'est le cas, cette étiquette est appliquée au pixel courant. Sinon, une 

nouvelle valeur d'étiquette lui est attribuée. Au final, un objet est donc constitué de 

l'ensemble des pixels porteurs d'une même étiquette. 

Dans ce plugin, deux filtres sont ajustables afin de sélectionner les objets à étudier : 

- La taille : afin de sélectionner des objets dont la taille est comprise dans la fourchette 

de taille mentionnée (en dehors de cette fourchette, les objets seront ignorés) 

- La circularité : afin de sélectionner les objets en fonction de leur forme (0 : pas  

Circulaire, 1 : cercle parfait). La formule utilisée est 4pi (surface/périmètre²). [28] 

D'autres options sont sélectionnables : 

 Show : pour choisir comment sont affichés les résultats (Outline : 

Carte des contours, Mask : Image binarisée, Ellipses : Affiche une image comportant 

des ellipses ajustées sur chacun des contours des objets, Count Mask : Carte étiquetée 

des objets) 

 Display résulte : affiche les résultats objet par objet 

 Clear résulte : efface les résultats de l'analyse précédente 

 Add to manager : pour que les objets détectés soient enregistrées dans le ROI 

Manager 

 Exclude on edge : exclue les objets qui touchent les bords 
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 Summarize : affiche dans une fenêtre séparée la moyenne des mesures 

sélectionnées dans Set measurements 

Ces différentes options sont illustrées dans la figure suivante : 

 

 

Voici un exemple de résultats obtenus grâce au plugin Analyze Particle : 
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III. 6.Opération sur les images 

Opérations mathématiques avec une constante 

Le menu Process > Math permet d’effectuer des opérations semblables à Process 

>Image 

Calculator mais avec des constantes. Voici le détail des fonctions : 

Add : Ajoute une constante à l’image ou la sélection. Avec une image 8-bits, un 

résultat supérieur à 0 autre la valeur 255. Avec une image 16 bits la valeur maximale 

sera 65535. 

Substrat : Soustrait une constant à l’image ou la sélection. Avec une image 8-bits ou 

16-bits la valeur minimale du résultat sera 0. Pour une Image 8-bits le résultat sera 

compris entre 0 et 255, pour une image 16-bits il sera compris entre 0 et 65 535. 

Davide : Divise l’image ou la sélection par la constante spécifiée. Excepté pour les 

images 32- bits, une division par 0 sera ignorée. Avec une image 32- bits, une division 

par 0 donnera soit NaN (Not a Number) ou Infini. 

Min : Les pixels dont la valeur est plus petite que la constante spécifiée seront 

remplacés par cette constante. 

Max : Les pixels dont la valeur est plus grande que la constante spécifiée seront 

remplacés par cette constante. 

Gamme : Applique la fonction suivante f(p)= (p/255)^gamma*255 à chaque pixel où 

0,1 <= gamma <=5,0. Pour les images couleurs cette fonction est appliquée à chaque 

canal R, G et B. 

Set : Remplit la sélection ou l’image par la valeur spécifiée. 

Log : Pour les images 8-bits, applique la fonction suivante f(p) = log(p)*255/log(255) 

à chaque pixel de l’image ou de la sélection. Pour les images RGB, cette fonction est 

appliquée à chaque canal. 

Reciprocal : Génère une image réciproque, uniquement pour les images 32-bits. 

Abs : Génère une valeur absolue de l’image active ou de la sélection. 

Fonctionne uniquement avec les images 32-bits. [33] 
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III. 7. Raccourcis claviers [33] 

Commande Raccourci Description 

New>Image n Crée une nouvelle image ou 

stack 

Open o Ouvre TIFF, JPEG, BMP, 

DICOM, FITS, etc. 

Open Next Shift+o Ouvre I’image suivante du 

dossier 

Close w Ferme la fenêtre active   

Save S Sauve la fenêtre active en 

format Tiff  

Revert R Revient à la version 

sauvegardée de I’image  

Print P Imprime I’image active  

Undo Z Annule la dernière opération   

Cut X Coupe la sélection 

Copy C Copie la sélection  

Paste V Colle la sélection 

Clear Backs pace Efface la sélection  

Fill F Rempli la sélection avec la 

couleur sélectionnée 

Draw D Dessine la sélection 

Invert Shift+i Inverse I ’intensité des pixels 

de I’image ou de la sélection 

Sélection>Select All  A Sélection I’image entière 

Sélection>Select None Shift+a Efface la sélection  

Sélection>Restore Shift+e Restaure la sélection 

précédente 

Sélection>Add to 

Manager 

T Ajoute la sélection au ROI 

Manager 

Adjust>Contrast Shift+c Affiche la fenêtre de 

Brillance/Contraste 
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Adjust>Threshold Shift+t Affiche la fenêtre de seuil 

Show Info I Affiche les informations de 

I’image 

Propretés Shift+p Affiche les propriétés de 

I’image 

Color>Color Picter Shift+k Ouvre le “Color Picker“ 

Stachs>Next Slice >or→ Affiche le slice suivant du 

stack 

Stachs>Previous Slice <or← Affiche le slice précédent du 

stack 

Stacks>Animation \ Dèmarre/ Arrete l’animation 

du stack 

Hyperstacks>Cannels Shift+z Ouvre l’outil “Channels“ 

Hyperstacks >or→ Affiche le canal suivant de 

l’hyperstack 

Hyperstacks <or← Affiche le canal précédent de 

l’hyperstack 

Hyperstacks Ctrl+> Affiche le slice suivant de 

l’hyperstack 

Hyperstacks Ctrl+< Affiche le slice précédent de 

l’hyperstack 

Hyperstacks Alt+> Affiche le temps suivant de 

l’hyperstack 

Hyperstacks Alt+< Affiche le temps précédent de 

l’hyperstack 

Crop Shift+x Croppe l’image active ou la 

sélection 

Duplicate Shift+d Dupplique l’image active ou 

la sélection 

Scale E Redimensionne l’image ou la 

sélection 

Zoom>In + ou↑ Zoome 

Zoom>Out + ou ↓ Dézoome 
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Zoom>Original Scale 4 Revient au zoom original 

Zoom>View100% 5 Zoom 1 :1 

Smooth Shift+s Applique un smooth 3*3 

Repeat Command Shift+r Répète la commande 

précédemment faite 

Measure M Affiche les statistiques de 

l’image active ou de 

la sélection 

Histogram H Affiche l’histogramme de 

l’image active ou de 

la sélection 

Histogram H Affiche l’histogramme de 

l’image active ou de la 

sélection 

Polt Profile K Affiche le profil de la 

sélection 

Utilities>Capture Screen Shift+g Réalise une capture d’écran 

Show All Shift+f Affiche toutes les images 

Put Behind tab Passe à l’image suivante 

ImageJ enter Passe la barre U en premier 

 

III.8. Ce Que ImageJ ne fait pas 

Dans le monde des logiciels d’imagerie numérique, les genres sont souvent 

confondus et il n’est pas inutile de mentionner ce que ne fait pas ImageJ. 

FireWire. 

3D : bien que ImageJ puisse tirer parti de certains 

plugins de rendu 3D, ils demeurent néanmoins moins efficaces et moins interactifs que 

les logiciels spécialisés. 

cette tâche. 
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lyse statistique. Typiquement, dans une chaîne complète 

d’analyse d’images, les résultats bruts sont extraits par ImageJ et stockés sur fichiers. 

Ils sont ensuite repris par un logiciel d’analyse de données comme MS Excel/Open 

Office Calc, Matlab/Octave ou R. 

plutôt rare qu’une tâche d’analyse d’images entre simplement dans une catégorie 

standard. Il faut alors recourir au développement d’un programme spécialisé par macro 

ou par plugin et c’est là qu’intervient la programmable de ImageJ. [32] 

III.9.Tybe, résolution, compression des images 

On distingue deux types d’images à la composition et au comportement différent 

III.9.1.Images matricielles et les images vectorielles. 

a-Images matricielles (ou images bitmap) 

Elle est composée comme son nom l’indique d’une matrice (tableau) de points à 

plusieurs dimensions, chaque dimension représentant une dimension spatiale (hauteur, 

largeur), ou autre (niveau de résolution). Dans le cas des images à deux dimensions, les 

points sont appelés pixels. 

b-Images vectorielles 

Elle est composée de différents objets repérés par leurs coordonnées et 

comportant différentes attributs (borure, fond, forme, coordonnées). Leur codage 

dépend directement du logiciel qui a permis de les créer. 

c-Résolution d’une image (dpi) 

La résolution d’une image est définie par un nombre de pixels par unité de 

longueur. Dot Per inch (ou dpi) par exemple. Plus ce nombre est élevé, plus la quantité 

d’information qui décrit cette structure est importante et plus la résolution est élevée. 

La résolution d’une image numérique définit le degré de détail de l’image. Ainsi, plus 

la résolution est élevée, meilleure est le rendu final. Augmenter la résolution peut 

entrainer des temps de visualisation et d’impression plus long, et conduire à une taille 

trop importante du fichier contenant l’image et à de la place excessive occupée en 

mémoire. 
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Résolution de l’objectif : la résolution d’une image est la distance minimale à partir 

de laquelle deux objets peuvent être discriminés. 

En optique, l’image d’un point n’est pas un point mais une tâche d’Airy due à la 

diffraction des rayons lumineux par le système optique. 

La résolution du système est donc limitée par la diffraction et correspond à la 

distance entre deux objets pour laquelle le maximum d’intensité du disque d’Airy du 

premier objet correspond au premier minimum d’intensité du disque d’Airy du second 

objet. 

La résolution latérale théorique d’une image en microscopie confocale ? Peut se 

calculer grâce à la formule suivante : 

r = (0,4*λem)/ON 

Avec λem la longueur d’onde d’émission et ON l’ouverture numérique de l’objectif. 

Avec un objectif 63X d’ouverture numérique 1,3, on obtient alors une résolution 

latérale théorique de153 nm à une longueur d’onde d’émission de 500 nm. 

Afin de réaliser les acquisitions dans des conditions optimales, le théorème de Nyquist 

préconise d’acquérir avec une fréquence d’échantillonnage de r/2.3 soit ici un pixel de 

66 nm. Ceci est particulièrement important lorsque l’on réalise une étude de 

colocalisation où il est nécessaire que le pixel soit le plus petit possible. 

Attention : Cependant, il ne faut pas sur-échantillonner les images (c’est –à-dire avoir 

un pixel de taille inférieur à ce que préconise le théorème de Nyquist). En effet, dans 

ce cas, on ne gagne pas en résolution mais il va y avoir un phénomène d’aliasing 

(artefact=“création d’un signal “qui n’existe pas en réalité) Plus il y a de pixels dans 

l’image, plus l’image va être longue à acquérir et donc plus votre échantillon va être 

illuminé (cela pouvant générer du photo-blanchements). De même, une image avec 

beaucoup de pixels sera plus volumineuse 

d- Dynamique de l’image 

La dynamique de l’image est le nombre de bits associés à chaque couleur primaire 

d’un pixel. Cette valeur reflète le nombre de couleurs ou de niveaux de gris d’une image 

: 32 bits = 1.07 milliards de couleurs 24 bits = 16.7 millions de couleurs (ou couleurs 

vraies) 16 bits = 65 536 couleurs 8 bits = 256 couleurs 1 bits = 2 couleurs (noir et blanc). 
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En microscopie confocale, l’utilisateur peut choisir la dynamique de l’image à 

acquérir alors que le 12 bits est une dynamique classique des caméras CCD utilisées en 

microscopie. 

L’œil humain n’est capable de distinguer que 50 à 60 niveaux de gris. Acquérir 

en 8 bits est donc souvent suffisant. Cependant, lorsque l’on souhaite analyser ses 

image, il est nécessaire de les acquérir en 12 bits car il y a ainsi beaucoup plus 

d’information en 12 bits est plus volumineuse qu’une image acquise en 8 bits. 

e- Représentation des couleurs 

IL existe plusieurs modes de codage informatique des couleurs, le plus utilisé 

pour le maniement des images est l’espace colorimétrique Rouge, Vert, Bleu (RVB ou 

RGB). Cet espace est basé sur une synthèse additive des couleurs, c’est-à-dire que le 

mélange des trois composants R, V, et B à leur valeur maximum donne du blanc, à 

l’instar de la lumière. 

Le mélange de ces trois couleurs à des proportions diverses permet quasiment de 

reproduire à l’écran toutes les couleurs du spectre visible, sans avoir à spécifier une 

multitude de fréquences lumineuses. Il existe d’autres modes de représentation des 

couleurs : Cyan, Magenta, Jaune, Noir (CMJN ou CMYK) utilisé principalement pour 

l’impression ; Teinte, Saturation, Luminance (TSL ou HSL), où la couleur est codée 

suivant le cercle des couleurs ; base de couleur optimale YUV, Y représentant la 

luminance, U et V deux chrominances orthogonales. 

f- Images avec gestion de la transparence 

On peut attribuer à une image un canal supplémentaire, appelé canal alpha, qui 

définit le degré de transparence de l’image [33]. 



 

 

 

 

 

 

 

 

 

 

 

 

Deuxième partie 

Application  
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1.Barre d’échelle sous ImageJ 

 But : insérer une barre d’échaelle dans l’image 

Première étape : Calcul de l’échelle 

 Soit x valeur du pixel de l’image en µm 

x= (taille pixel caméra *binning / objectif) / lentille 

taille pixel caméra : selon les microscopes 

objectif : voir le grossissement choisi 

binning : voir suivant le binning choisi (1,2 ou plus). 

Lentille : 1 ou 1.6 (selon les microsopes :1 ou 1,6 pour les microscopes Leica de la plate-

forme.1 pour les autres microscopes) 

Exemple avec le microscope Nikon 

Taille pixel caméra : 4.65µm (voir site de la plate forme sur intranet) 

Objectif : x60 

Binning : 2 

Lentille :1 

X (pixel)=(4.65*2/60)/1 =0,155 µm 

 Deuxième étape : ImageJ 

1. Ouvrir une image : File_ Open1 

Sélectionner l’image à laquelle on veut intégrer une barre d’échelle 
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2. Mise à l’échelle de l’image : Analyse_set scale 

 

Distance in pixel = 1 

Distance connue = x 

Ratio = 1 

Unité = µm (pour micromètre) 

Cocher global (pour appliquer à toutes les images ouvertes) 

Ok 

3. Affichage de la barre d’échelle sur l’image : Analyse _ Tools_ Scale Bar 

Width in µm : taille de la barre d’échelle sur l’image. 

Height in pixel : largeur de la barre d’échelle. 

Color : Couleur de la barre d’échelle (dans le cas d’une image RGB). 

Location : Position de la barre d’échelle dans l’image. 
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III.3.Prise en main du Logiciel 

III.3.A.Caractéristiques des images  

- Ouvrir A4Dapi. tif. Noter les informations disponibles sur l’image (haut de la fenêtre : 

nombre de pixels, type d’images, taille de l’image dans la mémoire de l’ordinateur) 

- Sélectionner la loupe dans la barre de menu, cliquer dans l’image : clic gauche = zoom 

interne, clic droit = zoom externe. 

- Agrandissez l’image pour faire apparaitre un indicateur rectangulaire indiquant que 

l’image est plus grande que la fenêtre et la position ou vous vous situez dans l’image. 

- Cliquer sur la main dans la barre des menus. Revenez sur l’image, cliquez dans l’image 

et conservez le doigt sur la souris. Déplacer l’image, et refaites un zoome dans l’image. 

- Agrandissez votre image au maximum, et positionnez votre souris sur un pixel grisé. 

Notez dans l’interface ImageJ, la position du pixel et la valeur de gris. 

III.3.B.Les outils de sélection 

- Dans la barre des menus, vérifiez que le rectangle de sélection est activé (cliquez 

dessus), et sélectionnez une partie de votre image en cliquant sur un point et déplaçant 

la souris. Dès que vous relâchez la souris, la sélection est établie. En recliquant dessus, 

vous pouvez modifiez sa position, et en cliquant sur les carres blancs étendre ou non 

votre cadre. 
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- Testez les autres outils de sélection (ovale, main levée…) 

- Réalisez une sélection et utilisez la commande Duplicate (Image>Crop) 

- Vous pouvez revenir à l’image initiale dans File> Revet (Crt+r) 

- Refaites une sélection et lancer la commande Duplicate (Image>Duplicate). 

Qu’observez-vous ? 

III.3.C. Les outils de mesure  

La commande (Analyze>Measure), mesure l’image ou des parties sélectionnées de l’image si 

une sélection est établie. Avec la commande (Analyze>Set measurements), vous pouvez 

sélectionnez ce que vous souhaitez mesurer [surface (area), périmètre objet (perimeter)…]. Les 

résultats de mesure sont fournis dans une table (Analyze>Measure) 

- Avec l’outil main levée, sélectionnez un noyau e évaluez sa surface e ses gris. Refaites 

la même chose en sélectionnant plusieurs noyaux. Pensez à zoomer dans l’image pour 

faire une sélection précise. 

- Dupliquer vos résultats depuis la table de résultats (File>Duplicate) 

- Refaites une sélection de plusieurs noyaux et remarquez où les résultats sont présentés. 

- Effacer l’ensemble de vos résultats (Results>Clear) et refaites une sélection de 3 

noyaux. Dans Results>Summarize et Results>Distriibution, observez les paramètres 

présentés [min, max distribution] 

III.3.D. Les outils lignes  

 Testez les différents outils lignes : ligne droite, ligne segmentée… (Cliquez sur le bouton 

droit de la souris) et l’outil angle par rapport à l’axe x. 

- Estimer la distance entre 2 noyaux 

- Estimer le diamètre d’un noyau 

- Estimer le périmètre d’un noyau 

- Estimer l’angle entre 3 noyaux 

Vous noterez que les valeurs de distance sont données en pixels, il faudra donc calibrer 

l’image pour obtenir des valeurs « réelle »en centimètres ou micromètres de l’objet. 

III.3.E. Les outils de comptage 

 L’outil étoile permet le comptage objet /objet, ou le comptage multiple. 
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- Sélectionnez 3 noyaux, puis faites une sélection dans l’arrière-plan, puis continuez à 

compter les noyaux. supprimer le comptage de l’arrière-plan (alt. clic). Que remarquez-

vous dans la numérotation des objets ? 

- Sauvegardez votre image avec les points de comptage. Fermez et rouvrez votre image, 

observez-vous toujours les numéros, pouvez-vous les modifier ? 

- Regardez la table de résultats (Analyze>Measure), chaque point de sélection est 

identifié par ses cordonnées x/y. 

III.4. Calibration d’une image 

 Les caractéristiques de l’image / de la sélection sont données jusqu’à présent en pixels. 

Il est nécessaire d’établir une corrélation entre taille réelle de /la sélection l’objet/et taille de 

pixel, avant toute modification de votre image (agrandissement, reduction, crop…) pour ensuite 

pouvoir présenter une barre d’échelle sur votre objet. C’est l’étape de calibration. 

 Après un agrandissement de l’image le pixel « apparait » plus grand à l’écran mais il 

représente toujours la même taille pour l’objet : 

 Largeur réelle de l’image/l’objet (µm)= nombre de pixels x taille réelle du pixel (µm) 

Ouvrir l’image lignes : la flèche du haut a une longueur réelle de 7 cm, la flèche du bas de 7.5 

cm 

- Tracer un trait sur la première flèche avec l’outil trait 

- Quelle est la longueur de ce trait en pixel ? 

- Vous connaissez maintenant la taille réelle du pixel (cm), et pouvez l’utiliser pour 

calibrer votre image. 

- Allez dans Images>Properties, choisissez le centimètre (cm) comme unité de longueur 

et rentrez vos valeurs en cm de hauteur et largeur de pixels. Validez  

- Qu’observez-vous au niveau des caractéristiques de votre image (barre au-dessus de 

l’image ?) 

 Modifications de l’image   

A) Seuillage d’une (Threshold) et sélection de zone d’intérêt (ROI=Regiion Of Interest) 

Ouvrir l’image  

- Dans Image>Adjust>Threshold, visualisez les différents canaux de TS. Modifiez-les. 
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Le ROI Manager est un outil qui permet de gérer les différentes sélections réalisées sur 

l’image. 

- Revenir sur l’image initiale  

- Allez dans Analyze>Tools>ROI Manager 

- Sélectionnez un noyau, puis un deuxième. Qu’observez-vous dans ROI Manager ? 

- Dans ROI Manager, cliquer sur Measure. Qu’observez-vous ? 

- Evaluez le diamètre et le périmètre de vos noyaux sélectionnés, via ROI Manager 

Vous pouvez sauvegarder dans un fichier tabulé (colonne, ligne, type fichier excelle) vos 

différentes ROI 

- Appliquer un TS a l’image de façon a séparer le fond de l’image des noyaux. (exemple : 

fond blanc, noyau noir) 

- Analyze >Analyze particles. Qu’observez-vous dans Roi manager et sur l’image ? 

B) Conversion de l’image  

- Convertissez l’image en niveau de gris en 8-bits (Image>Type>8-bit) 

- DUPLIQUER l’image (Image>Duplicate) 

- Ajouter du brui Process>Noise>Add Specified Noise et Standard deviation=25 

- Quel(s) filtre(s) diminu(ent) le mieux le bruit parmi : smooth, sharpen, find edges, 

gaussian, median, min, max dans Process. APPLIQUER CHACUN DES FILTRES 

SUR UNE COPIE DE L’IMAGE BRUTTEE POUR POUR POUVOIR COMPARER.  

- Reouvrir l’image d’origine, notez que l’application d’un filtre modifie de façon 

irréversible l’image, il faut donc travailler sur une copie de l’image (duplicate). 

III.7.Notions de Macros 

 Nous allons créer une macro qui permet d’enchainer les opérations suivantes : ouverture 

de l’image, TS de l’image, sélection des noyaux après TS, sauvegarde des résultats. 

- Allez dans Plugins>Macros>Record 

Dès cet instant toutes les opérations que vous allez réaliser seront prises en compte, après 

sauvegarde de cet enchainement de tache, votre macro sera crée 

1. Ouvrez l’image. Observez la fenêtre « Macro record » 

2.  Image>Adjust>Threshld : adaptez et appliquez votre TS. Observez la fenêtre «Macro 

record » 

3. Analyze>Analyze particles 
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4. ROI Manager>Measure : par défaut la surface de l’objet est évaluée 

5. Enregistrez votre macro : dans la fenêtre « Macro record » : Create>File>Save as> 

EssaiMacro 

- Tester votre macro apres avoir ferme tous vos fichiers : 

Plugins>Macros>Runs>EssaiMacro  

Application du logicielle sur quelques échantillons inconnues  

Les différentes étapes du travail après l’ouverture de l’image, sont illustrées par la succession 

des images suivantes. 

1 Ouvrir l’image 

 

2 Changement du type del’image 
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3 Précision de l’échèle  
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4 Application de la méthode manuelle pour calculer le diamètre des grains 

 

Il faut tracer plusieurs lignes de même longueurs et calculer le nombre de grains traverser pas 

chaque ligne. 

 

 

Tableau III.1 : résultats de la première méthode 

 G5 polissage 

 Length N d A d moy A moy 

1 186.916 18 10,38422222 107,8320707 10,79535359 116,5396593 

2 186.969 16 11,6855625 136,5523709 

3 186.910 16 11,681875 136,4662035 

4 186.942 19 9,839052632 96,80695666 

5 186.949 18 10,38605556 107,8701509 

 

N : Nombre de grains 

d : granulé moyne = Length /N 

A : Surface granulé = d^2 

d moy = ∑ d51  /N 



Chapitre III : ImageJ Présentation et teste d’application sur des échantillons d’acier 
 

70 
 

A moy = ∑ 𝐴51  /N 

5 Le choix d’un échantillon de la figure pour faciliter la sélection 

 

                    

6 Sélection des grains et calcul de leurs surfaces 

 

 

 

 G5 polissage 
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 1 2 3 4 5 6 7 8 

Area 

(µm2) 

57.774 53.330 31.998

  

37.331 97.771 43.997 19.554 17.332 

SA 

(µm2) 

359,087 

S 

(µm2) 

3841,5978 

SA/S 0,093473346 

% 9,347335 

C% 7,477868 

 

SA (µm2) = ∑ 𝐴81   

S (µm^2) : surface de l’image = 60,66*63,33 

SA/S = somme Area/ surface de l’image 

% = SA/S*100 

C% = (SA/S*100)*0,8 

 

 G5 polissage  

 1 

Area (µm 2) 339.088 

S (µm2) 3841,5978 

Area / S 0,088267439 

% perlite 8,826744 

C% 0.70613952 

 

SA=y 

S : surface des image = 37.46*22.08 

SA/S= Somme Area /surface d’image 

Pourcentage du perlite :  %P=SA/S*100 
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C%=(%P /100)*0.8 

 

Utilisation de la méthode Threshold pour déterminer directement le pourcentage de la phase 

perlite 

 

 

 

D’après ce logiciel le pourcentage du perlite est 20% 

%P=20% 

%C=0.2*0.8=0.16 

Interprétation  
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Nous remarquant une petite différence entre les résultats de deux méthode manuelle ou 

indirecte et celle directe par la commande Threshold et cela est due à la faible précision au 

cours de la sélection des grains manuellement mais les résultats reste voisine et acceptable. 
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Conclusion Générale  

 

En raison de l'importance du fer est de ces alliages notamment l’acier, ce type 

de métaux acquis une importance scientifique et technique très spécial. Dans ce travail 

nous voudrions déterminer les tailles de grains d'un acier inoxydable en utilisant le 

logiciel ImageJ dans le but de se familiariser avec ce dernier et le mettre sous 

l’observation des chercheurs qui s’intéressent à ce type de caractérisation de matériaux. 

Pour le faire, nous avons suivi plusieurs étapes, notamment le calcul de la 

distance et le calcul du nombre de grains, mais le plus important est de calculer le 

pourcentage de ferrite dans le but de prévoir le pourcentage du carbone dans un 

échantillon d’acier. Il y avait deux méthodes utilisées pour obtenir le résultat une 

méthode manuelle en sélectionnant les différents grains appartenant à la surface choisie 

pour l’étude et la deuxième méthode en utilisant la commande threshold. Les résultats 

sont proches en valeurs et la deuxième méthode est la plus utilisée car elle est la moins 

pénible. 

Ce logiciel peut être utilisé pour prédire le pourcentage du carbone dans les 

échantillons ou ce dernier est inconnu. Comme il peut pour être employer par les 

métallurgistes par exemple pour valider des résultats expérimentaux obtenus par 

d’autres méthodes. 

Pour conclure on peut dire que le logiciel ImageJ n’est pas seulement facile à 

manipuler mais également pratique et très impressionnant. 
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 ملخص

غير لا الفولاذلعينات من الحبيبات  حجمتحديد تمحورت حول عمل قمنا بدراسة نظرية في هذا ال

 االاطوار وانواعهيات منح حولنا بدراسة عامة أحيث بد  ImageJ البرنامج  قابل للصدأ باستخدام

حيث قمنا بوصف عمقة م بصفة Fer-Carboneمنحى الثم درسنا ا، بينه اتختتافالاوبصفة عامة 

في عد   هاواستعمالات اهتطبيقاتتطرقنا الى يما  اطوار مووود  في  وييفية الحصول عليهالامختلف 

ف الوظائ ابتداء من طريقة تثبيت  الى مختلف ImageJثم قمنا بعرض للبرنامج  .تكنولووية مجات

 وانتهينا بتطبيق  على بعض العينات المجهولة نسبة الكاربون حيث طبقنا طريقتين التي يتوفر عليها.

على  نا بالتقريبتحصلف Thresholdثم بتطبيق  تعليمة  يدويا في تحديد الحبيبات متمثلة الأولى

 د اليدوي.لتحدياثناء ا الأختطاءمن الطريقتين مع اختتافات بسيطة تعزى الى  نفس النسبة يربون

Résumé 

Dans ce travail, nous avons réalisé une étude hypothétiques dans le 

but de déterminer les tailles de grains des quelques échantillons d’acier 

inoxydables en appliquant le logiciel ImageJ. Où nous avons commencé 

par une étude générale sur les diagrammes de phases en s’appuyant sur 

ses différents types. Ensuite, nous avons étudié le diagramme Fer-Carbone 

avec plus de précision en exposant les différentes phases en présences dans 

ce système sans oublier les applications industrielle et technologiques de 

ces alliages. Nous avons exposer le logiciel ImageJ en commençant par 

son installation et ces différentes fonctionnalités.et nous l’avons appliquer 

sur quelque échantillon sans s’avoir initialement ces teneurs en carbone 

en effectuant deux méthodes la première est celle de la sélection manuelle 

des gains et la deuxième en appliquant la méthode Threshold, les résultats 

obtenus par les deux méthodes sont très proche et les petites différence sont 

dues à la précision lors de l’application de la méthode manuelle. 

Abstract 

The current research is a hypothetical study in the aim of the 

determination the gain size of stainless steel using the ImageJ. In which we 

began with a general study that includes the phase diagram and its 

different types, and this study becomes more specific on the Fe-C phase 

diagram. We also exposed the technical application of the Fe-C alloys. 

We have also tried to give more importance in the third section of this work 

on the ImageJ program from its installation to the exposition of his 

different instructions and we have applied this program on some steel 

using too diffferent methods, one manual by selecting the gains and the 

second by the instruction Threshold. The result was having the same 

percentage of Carbone. 
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